## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/19/2020</td>
<td>1.0</td>
<td>Initial Release</td>
<td>LibertyIT Solutions</td>
</tr>
</tbody>
</table>
# Table of Contents

1 Introduction .................................................................................................................. 1  
  1.1 Purpose ..................................................................................................................... 1  
  1.2 Document Orientation ............................................................................................. 1  
    1.2.1 Organization of the Guide .................................................................................. 2  
    1.2.2 Assumptions ........................................................................................................ 2  
    1.2.3 Disclaimers .......................................................................................................... 3  
      1.2.3.1 Software Disclaimer .................................................................................... 3  
      1.2.3.2 Documentation Disclaimer ......................................................................... 3  
    1.2.4 Documentation Conventions ............................................................................. 3  
    1.2.5 References and Resources ............................................................................... 3  
  1.3 National Service Desk and Organizational Contacts ........................................... 3  

2 System Summary .......................................................................................................... 5  
  2.1 System Configuration ....................................................................................... 5  
  2.2 Data Flows ........................................................................................................... 5  
  2.3 User Access Levels .............................................................................................. 6  
  2.4 Continuity of Operations ................................................................................... 6  
  2.5 Section 508 Compliance ................................................................................... 6  
    2.5.1 Screen Readers ............................................................................................. 6  

3 Getting Started ........................................................................................................... 7  
  3.1 Logging On ........................................................................................................... 8  
    3.1.1 Authentication via CPRS SSO ....................................................................... 9  
    3.1.2 Authentication via CCOW SSO ................................................................... 9  
    3.1.3 Authentication via Personal Identification Verification (PIV) ....................... 9  
    3.1.4 Authentication via Access and Verify Codes ............................................. 11  
  3.2 Event Capture Main Menu ............................................................................... 12  
    3.2.1 Icon Shortcuts .......................................................................................... 12  
    3.2.2 Menu Bar .................................................................................................. 13  
    3.2.3 Delete Test Patient Data ........................................................................... 14  
  3.3 Menu Bar for Specific Functions .................................................................... 15  
    3.3.1 Data Entry Menu Bar ............................................................................. 15  
    3.3.2 Spreadsheet Menu Bar ........................................................................... 15  
    3.3.3 Reports Menu Bar .................................................................................. 16  
    3.3.4 Management Menu Bars ........................................................................ 16  
  3.4 Changing User ID and Password ..................................................................... 17  
  3.5 Exit System ....................................................................................................... 17  
  3.6 Caveats and Exceptions .................................................................................. 17  
  3.7 Online Documentation .................................................................................. 17  
  3.8 Timeout Feature .............................................................................................. 18  

4 Using the Software ................................................................................................... 19
4.1 Data Entry Menu ........................................................................................................ 19
  4.1.1 Data Entry by Patient ............................................................................................ 19
    4.1.1.1 Enter/Edit Patient Procedures Screen ......................................................... 20
    4.1.1.2 Recent Visits Screen ..................................................................................... 22
    4.1.1.3 Add Information to the Add Patient Procedure or Edit Patient Procedure Screen ................................................................................................................................. 25
    4.1.1.4 Add a Patient Procedure .................................................................................. 27
    4.1.1.5 Edit a Patient Procedure .................................................................................. 30
    4.1.1.6 Delete a Patient Procedure .............................................................................. 33
  4.1.2 Data Entry by Procedure ....................................................................................... 34
    4.1.2.1 Add a Procedure for Multiple Patients .......................................................... 35
  4.1.3 Multiple Dates / Multiple Procedures .................................................................... 39
    4.1.3.1 Instructions for Common Fields ...................................................................... 40
    4.1.3.2 Add Information to the Providers Tab ............................................................ 41
    4.1.3.3 Add Information to Procedures Tab ................................................................. 42
    4.1.3.4 Add Information to the Select Patient Tab ....................................................... 44
    4.1.3.5 Verify Information Using the View Selected Patients Tab ................................ 46
    4.1.3.6 Verify Information Using the Records Pending Filing Tab ............................. 47
  4.2 Spreadsheet ............................................................................................................ 49
    4.2.1 Import a Regular Spreadsheet ......................................................................... 49
      4.2.1.1 Regular Spreadsheet Fields ........................................................................ 50
      4.2.1.2 Edit Cell Data on the Spreadsheet Upload Form ........................................ 54
      4.2.1.3 Modify Column Order .................................................................................. 55
    4.2.2 Import a State Home Spreadsheet ...................................................................... 56
    4.2.3 Upload Imported Spreadsheet Data ..................................................................... 58
      4.2.3.1 Spreadsheet Upload Errors ......................................................................... 58
      4.2.3.2 Service Connected Questions Validation ...................................................... 61
      4.2.3.3 Duplicate Record Errors .............................................................................. 62
    4.2.4 Upload Completion .............................................................................................. 63
  4.3 Reports ....................................................................................................................... 63
    4.3.1 Reports Available to All Users .......................................................................... 63
      4.3.1.1 DSS Unit Activity Report ............................................................................. 64
      4.3.1.2 DSS Unit Workload Report ......................................................................... 66
      4.3.1.3 ECS Records Failing Transmission to PCE Report ...................................... 68
      4.3.1.4 Event Capture Encounters Report ................................................................. 70
      4.3.1.5 Ordering Section Summary Report ............................................................... 73
      4.3.1.6 Patient Summary Report .............................................................................. 74
      4.3.1.7 PCE Data Summary Report .......................................................................... 78
      4.3.1.8 Possible Late State Home Entries Report ...................................................... 80
      4.3.1.9 Procedure Reasons Report .......................................................................... 82
      4.3.1.10 Provider Summary Report ......................................................................... 84
      4.3.1.11 Provider (1-7) Summary Report ................................................................. 86
    4.3.2 Reports Available to ECMGR Key Holders Only .............................................. 88
      4.3.2.1 Category Report ........................................................................................... 89
      4.3.2.2 Disabled Category and Procedure Summary ............................................... 91
      4.3.2.3 DSS Units with Any Associated Stop Code Errors Report ........................... 93
      4.3.2.4 DSS Units/Event Code (EC) Screens for Selected Procedure Code Report .... 95
      4.3.2.5 DSS Unit User Access Report ..................................................................... 97
4.3.2.6 Event Code Screens with CPT Codes Report ....................................................... 98
4.3.2.7 Event Code Screens with Inactive Default Associated Clinic Report ............. 100
4.3.2.8 Inactive Person Class Report (IPC) .................................................................... 102
4.3.2.9 National/Local Procedure Codes with Inactive CPT Codes Report .............. 103
4.3.2.10 National/Local Procedure Report – Active Procedures ............................... 105
4.3.2.11 National/Local Procedure Report – Inactive Procedures ............................. 107
4.3.2.12 Print Category and Procedure Summary (Report) ....................................... 109
4.3.2.13 Send No Records DSS Units Report ................................................................. 111

4.4 Management Menu .................................................................................................. 113
4.4.1 Location – Update Location Information .............................................................. 114
4.4.2 DSS Unit – Add or Update DSS Units ................................................................ 117
  4.4.2.1 To Add a DSS Unit .......................................................................................... 120
  4.4.2.2 Update a DSS Unit ....................................................................................... 121
  4.4.2.3 To Grant Access to a DSS Unit ....................................................................... 122
  4.4.2.4 To Disable Categories for a DSS Unit ............................................................. 123
4.4.3 Access by User - Grant Access to DSS Units by User ........................................ 125
  4.4.3.1 Assign User Access to DSS Units .................................................................. 126
4.4.4 Category - Add or Update Categories ................................................................... 127
  4.4.4.1 Add Categories .............................................................................................. 128
  4.4.4.2 Update Categories ....................................................................................... 128
4.4.5 Procedure - Add or Update Local Procedures ..................................................... 129
  4.4.5.1 Add Procedures ............................................................................................ 130
  4.4.5.2 Update Procedures ....................................................................................... 131
4.4.6 Reason - Add or Update Procedure Reasons ....................................................... 132
  4.4.6.1 Activate Reasons .......................................................................................... 133
  4.4.6.2 Inactivate Reasons ...................................................................................... 134
  4.4.6.3 Add a New Reason ....................................................................................... 135
4.4.7 Event Code Screen - Add, Update, or Copy Event Code Screens ....................... 136
  4.4.7.1 Add Event Code Screens .............................................................................. 138
  4.4.7.2 Update Event Code Screens .......................................................................... 139
  4.4.7.3 Copy Event Code Screens to Another DSS Unit ........................................... 140
4.4.8 Inactivate EC Screen - Identify Inactive Multiple Event Code Screens ............ 143
  4.4.8.1 Inactivate Event Code Screen(s) .................................................................. 144
4.4.9 Providers - Maintain Non-Licensed Providers .................................................... 145
  4.4.9.1 Add a Non-Licensed Provider ..................................................................... 146
  4.4.9.2 Remove a Non-Licensed Provider ................................................................. 147

5 Troubleshooting ............................................................................................................. 148
5.1 Access Issues ............................................................................................................ 148
5.2 Log On Issues ........................................................................................................... 148
5.3 GUI Appears Distorted .............................................................................................. 148
  5.3.1 Example of Setting the Screen Resolution to 1920 x1080 .................................. 148

Appendix A. Acronyms and Abbreviations .................................................................. A-1
Appendix B. Glossary ........................................................................................................ B-1
Appendix C. Other ECS Package Management Information ........................................ C-1
Appendix D. Index .................................................................................... D-1

List of Tables

Table 1: Tier Support Contact Information ......................................................... 4
Table 2: Element Name and Description ............................................................. 119
Table 3: Acronyms and Abbreviations ............................................................... A-1
Table 4: Glossary Terms ...................................................................................... B-1

List of Figures

Figure 1: ECS Data Flow Diagram 5
Figure 2: ECS GUI Icon 8
Figure 3: Event Capture CCOW Status 9
Figure 4: PIV Certificate Selection 10
Figure 5: PIN Entry 10
Figure 6: System Use Notification 11
Figure 7: VistA Login Screen 11
Figure 8: Main Menu for Event Capture 12
Figure 9: Main Menu for Users with the ECNORPT Security Key 12
Figure 10: Icon Shortcuts 13
Figure 11: Main Menu Bar 13
Figure 12: Main Menu Bar with Menus Expanded 14
Figure 13: Delete Test Patient Data Dialog Box 14
Figure 14: Data Entry Menu Bar Options 15
Figure 15: Data Entry with Menus Expanded 15
Figure 16: Spreadsheet Menu Bar Options 15
Figure 17: Spreadsheet Menu Bar with Menus Expanded 16
Figure 18: Reports Menu Bar Options 16
Figure 19: Reports Menu with Menus Expanded 16
Figure 20: Management Menu Options 17
Figure 21: Management Menu with Menus Expanded 17
Figure 22: Online Help Screen 18
Figure 23: Event Capture Timeout Screen 18
Figure 24: Data Entry Menu Screen 19
Figure 25: Enter/Edit Patient Procedures Screen 20
Figure 26: Calendar Dropdown for Date Range View 21
Figure 27: Procedure History for Sample Patient 22
Figure 28: Recent Visits Screen 23
Figure 29: Add Patient Procedure Detail Screen 24
Figure 30: Error: Invalid Associated Clinic Message Dialog 24
Figure 31: Select Date/Time Dialog Box 25
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 32</td>
<td>Service Connection and Rated Disabilities Screen</td>
<td>26</td>
</tr>
<tr>
<td>Figure 33</td>
<td>Enter/Edit Patient Procedures Screen</td>
<td>28</td>
</tr>
<tr>
<td>Figure 34</td>
<td>Recent Visits Screen</td>
<td>28</td>
</tr>
<tr>
<td>Figure 35</td>
<td>Add Patient Procedure Screen</td>
<td>29</td>
</tr>
<tr>
<td>Figure 36</td>
<td>Enter/Edit Patient Procedures with New Procedure Added</td>
<td>30</td>
</tr>
<tr>
<td>Figure 37</td>
<td>Enter/Edit Patient Procedures Screen</td>
<td>31</td>
</tr>
<tr>
<td>Figure 38</td>
<td>Edit Patient Procedure Screen</td>
<td>32</td>
</tr>
<tr>
<td>Figure 39</td>
<td>Enter/Edit Patient Procedures Screen</td>
<td>33</td>
</tr>
<tr>
<td>Figure 40</td>
<td>Procedure Deleted Confirmation Dialog</td>
<td>33</td>
</tr>
<tr>
<td>Figure 41</td>
<td>Information Message</td>
<td>34</td>
</tr>
<tr>
<td>Figure 42</td>
<td>Enter/Edit Patient Procedures Screen with Procedure Deleted</td>
<td>34</td>
</tr>
<tr>
<td>Figure 43</td>
<td>Same Procedure, Multiple Patients Screen</td>
<td>35</td>
</tr>
<tr>
<td>Figure 44</td>
<td>Select Date/Time Dialog</td>
<td>36</td>
</tr>
<tr>
<td>Figure 45</td>
<td>Service Connection and Rated Disabilities Dialog</td>
<td>37</td>
</tr>
<tr>
<td>Figure 46</td>
<td>View Patients for this Procedure Screen</td>
<td>38</td>
</tr>
<tr>
<td>Figure 47</td>
<td>Multiple Dates/Multiple Procedures Screen – Initial Screen</td>
<td>39</td>
</tr>
<tr>
<td>Figure 48</td>
<td>Select Date/Time Dialog</td>
<td>40</td>
</tr>
<tr>
<td>Figure 49</td>
<td>Multiple Dates/Multiple Procedures Screen, Providers Tab</td>
<td>41</td>
</tr>
<tr>
<td>Figure 50</td>
<td>Multiple Dates/Multiple Procedures Screen, Procedures Tab</td>
<td>42</td>
</tr>
<tr>
<td>Figure 51</td>
<td>View Procedure Record Details Screen</td>
<td>43</td>
</tr>
<tr>
<td>Figure 52</td>
<td>Multiple Dates/Multiple Procedures Screen, Select Patient Tab</td>
<td>44</td>
</tr>
<tr>
<td>Figure 53</td>
<td>Service Connection and Rated Disabilities Dialog</td>
<td>45</td>
</tr>
<tr>
<td>Figure 54</td>
<td>Multiple Dates/Multiple Procedures View Selected Patients Tab</td>
<td>46</td>
</tr>
<tr>
<td>Figure 55</td>
<td>Deleting Patient Confirmation Dialog</td>
<td>46</td>
</tr>
<tr>
<td>Figure 56</td>
<td>View Patient Record Details Screen</td>
<td>47</td>
</tr>
<tr>
<td>Figure 57</td>
<td>Multiple Dates/Multiple Procedures Records Pending Filing Tab</td>
<td>48</td>
</tr>
<tr>
<td>Figure 58</td>
<td>Information Dialog after Saving</td>
<td>48</td>
</tr>
<tr>
<td>Figure 59</td>
<td>Spreadsheet Upload Screen Before Import</td>
<td>49</td>
</tr>
<tr>
<td>Figure 60</td>
<td>Imported Spreadsheet Data Shown in the Spreadsheet Upload Form</td>
<td>50</td>
</tr>
<tr>
<td>Figure 61</td>
<td>Spreadsheet Upload – Edit Functions</td>
<td>54</td>
</tr>
<tr>
<td>Figure 62</td>
<td>Column Headers Form</td>
<td>55</td>
</tr>
<tr>
<td>Figure 63</td>
<td>Select File Dialog - Open a State Home Spreadsheet</td>
<td>57</td>
</tr>
<tr>
<td>Figure 64</td>
<td>Additional Data Form for State Home Spreadsheet Import</td>
<td>57</td>
</tr>
<tr>
<td>Figure 65</td>
<td>Service Connected Error Messages and Create Error XLS Button</td>
<td>61</td>
</tr>
<tr>
<td>Figure 66</td>
<td>Export Errors – SC Data Required</td>
<td>62</td>
</tr>
<tr>
<td>Figure 67</td>
<td>Export Errors – Other Errors</td>
<td>62</td>
</tr>
<tr>
<td>Figure 68</td>
<td>Duplicate Record Threshold Reached Screen</td>
<td>62</td>
</tr>
<tr>
<td>Figure 69</td>
<td>Spreadsheet Upload Progress Indicator</td>
<td>63</td>
</tr>
<tr>
<td>Figure 70</td>
<td>Reports Available to All Users</td>
<td>64</td>
</tr>
<tr>
<td>Figure 71</td>
<td>DSS Unit Activity Report Selection Criteria</td>
<td>65</td>
</tr>
<tr>
<td>Figure 72</td>
<td>Report Preview - DSS Unit Activity Report</td>
<td>66</td>
</tr>
<tr>
<td>Figure 73</td>
<td>Export - DSS Unit Activity Report</td>
<td>66</td>
</tr>
<tr>
<td>Figure 74</td>
<td>DSS Unit Workload Report Selection Criteria</td>
<td>67</td>
</tr>
<tr>
<td>Figure 75</td>
<td>Report Preview - DSS Unit Workload Report</td>
<td>68</td>
</tr>
</tbody>
</table>
Figure 76: Export - DSS Unit Workload Report
Figure 77: ECS Records Failing Transmission to PCE Report Selection Criteria
Figure 78: Report Preview - ECS Records Failing Transmission to PCE Report
Figure 79: Export - ECS Records Failing Transmission to PCE Report
Figure 80: Event Capture Encounters Report Selection Criteria
Figure 81: Event Capture Encounters Report Timeout Warning
Figure 82: Report Preview - Event Capture Encounters Report Sorted by Patient
Figure 83: Report Preview - Event Capture Encounters Report Sorted by Provider
Figure 84: Export - Event Capture Encounters Report
Figure 85: Ordering Section Summary Report Selection Criteria
Figure 86: Report Preview - Ordering Section Summary Report
Figure 87: Export - Ordering Section Summary Report
Figure 88: Patient Summary Report (without Reasons) Selection Criteria
Figure 89: Report Preview - Patient Summary Report (without Reasons)
Figure 90: Export - Patient Summary Report (without Reasons)
Figure 91: Patient Summary Report (with Reasons) Selection Criteria
Figure 92: Report Preview - Patient Summary Report (with Reasons)
Figure 93: Export - Patient Summary Report (with Reasons)
Figure 94: PCE Data Summary Report Selection Criteria
Figure 95: Report Preview - PCE Data Summary Report
Figure 96: Export - PCE Data Summary Report
Figure 97: Possible Late State Home Entries Report Selection Criteria
Figure 98: Report Preview - Possible Late State Home Entries Report
Figure 99: Export - Possible Late State Home Entries Report
Figure 100: Procedure Reasons Report Selection Criteria
Figure 101: Report Preview - Procedure Reasons Report
Figure 102: Export - Procedure Reasons Report
Figure 103: Provider Summary Report Selection Criteria
Figure 104: Preview - Provider Summary Report
Figure 105: Export - Provider Summary Report
Figure 106: Provider (1-7) Summary Report Selection Criteria
Figure 107: Preview – Provider (1-7) Summary Report
Figure 108: Export - Provider (1-7) Summary Report
Figure 109: Report Selection Screen for ECMGR Key Holders
Figure 110: Category Report Selection Criteria
Figure 111: Report Preview - Category Report (Active)
Figure 112: Export - Category Report (Active)
Figure 113: Report Preview - Category Report (Inactive)
Figure 114: Export - Category Report (Inactive)
Figure 115: Report Preview - Category Report (Both Active and Inactive)
Figure 116: Export - Category Report (Both Active and Inactive)
Figure 117: Disabled Category and Procedure Summary Report Selection Criteria
Figure 118: Report Preview - Disabled Category and Procedure Summary
Figure 119: Export - Disabled Category and Procedure Summary
Figure 120: DSS Units with Any Associated Stop Code Errors Selection Criteria 94
Figure 121: Report Preview - DSS Units with Any Associated Stop Code Errors 95
Figure 122: Export - DSS Units with Any Associated Stop Code Errors 95
Figure 123: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report Selection Criteria 96
Figure 124: Report Preview - DSS Units/Event Code (EC) Screens for Selected Procedure Code Report 96
Figure 125: Export - DSS Units/Event Code (EC) Screens for Selected Procedure Code Report 97
Figure 126: DSS Unit User Access Report Selection Criteria 97
Figure 127: Report Preview - DSS Unit User Access Report 98
Figure 128: Export - DSS Unit User Access Report 98
Figure 129: Event Code Screens with CPT Codes Report Selection Criteria 99
Figure 130: Preview - Event Code Screens with CPT Codes Report (Both Active and Inactive CPT Codes Selected) 100
Figure 131: Event Code Screens with CPT Codes Report from Export 100
Figure 132: Event Code Screens with Inactive Default Associated Clinic Selection Criteria 101
Figure 133: Preview - Event Code Screens with Inactive Default Associated Clinic 101
Figure 134: Export - Event Code Screens with Inactive Default Associated Clinic 102
Figure 135: Inactive Person Class Report Selection Criteria 102
Figure 136: Preview - Inactive Person Class Report 103
Figure 137: Export - Inactive Person Class Report 103
Figure 138: National/Local Procedure Codes with Inactive CPT Codes Selection Criteria 104
Figure 139: Report Preview - National/Local Procedure Codes with Inactive CPT Codes Report 104
Figure 140: Export - National/Local Procedure Codes with Inactive CPT Codes Report 105
Figure 141: National/Local Procedure Report (Active) Selection Criteria 106
Figure 142: Report Preview - National/Local Procedure Report (Active) 106
Figure 143: Export - National/Local Procedure Report (Active) 107
Figure 144: National/Local Procedure Report (Inactive) Selection Criteria 108
Figure 145: Preview - National/Local Procedure Report (Inactive) 108
Figure 146: Export - National/Local Procedure Report (Inactive) 109
Figure 147: Print Category and Procedure Summary (Report) Selection Criteria 110
Figure 148: Report Preview - Print Category and Procedure Summary (Report) 111
Figure 149: Export - Print Category and Procedure Summary (Report) 111
Figure 150: Send No Records DSS Units Report Required Fields 112
Figure 151: Report Preview - Send No Records DSS Units Report 112
Figure 152: Export - Send No Records DSS Units Report 113
Figure 153: Event Capture Management Main Menu 114
Figure 154: Management Menu [Locations] Screen 115
Figure 155: Edit Location Screen 115
Figure 156: Sort Menu Options 116
Figure 157: Creating a Current Location 116
Figure 158: Removing a Current Location 116
Figure 159: Export - ECS Location Table 117
Figure 160: Management Menu [DSS Units] Screen 118
Figure 161: Export – DSS Units Table 118
Figure 162: Add a DSS Unit Screen 121
Figure 163: Edit DSS Unit Screen 121
Figure 164: DSS Unit Status Changed from Active to Inactive 122
Figure 165: DSS Unit Status Change from Inactive to Active 122
Figure 166: Grant Access to DSS Unit 123
Figure 167: Edit DSS Unit Screen Showing a DSS Unit Set to Allow Categories 124
Figure 168: Allow Category Use Set to No 124
Figure 169: Disable Category Warning Pop Up Message 124
Figure 170: Edit DSS Unit Screen After Disabling Categories 125
Figure 171: Grant Access to DSS Units by User 126
Figure 172: Grant Access to DSS Units by User – Adding DSS Units 127
Figure 173: Categories Main Screen on Management Menu 128
Figure 174: Add Category Screen 128
Figure 175: Update Category Screen 129
Figure 176: Export - ECS Category Table 129
Figure 177: Management Menu [Procedures] Screen 130
Figure 178: Add Local Procedure 130
Figure 179: Edit Local Procedure 131
Figure 180: Update After Editing a Local Procedure 132
Figure 181: Export – Procedures 132
Figure 182: Management Menu [Reasons] Screen 132
Figure 183: Reasons Screen with Inactive Reasons Selected 133
Figure 184: Reasons Screen with Inactive Reasons Moved to the Active Column 134
Figure 185: Confirmation Prompt 134
Figure 186: Reasons Screen with Active Reasons Highlighted 134
Figure 187: Reasons Screen with Active Reasons Moved to the Inactive Column 135
Figure 188: Confirmation Prompt 135
Figure 189: New Reason Screen 135
Figure 190: Reasons Screen with New Reason Added 136
Figure 191: Event Code Screens Example 137
Figure 192: Select Clinic Status for the Event Code Screens Listing 137
Figure 193: Exported Event Code Table Report 137
Figure 194: Add Event Code Screen 138
Figure 195: Event Code Screen Added 138
Figure 196: Add Event Code Screen - Record Not Filed Error 139
Figure 197: Update Event Code Screen Example 139
Figure 198: Update EC Screen Error – Invalid Associated Clinic 140
Figure 199: Update Event Code Screen – Select Default Associated Clinic 140
Figure 200: Event Code Screen with Active DSS Unit Selected 141
Figure 201: Edit > Copy EC Screens to another DSS Unit 141
| Figure 202 | Select a Target Screen | 141 |
| Figure 203 | Copy Event Code Screen to DSS Unit | 142 |
| Figure 204 | Record Not Filed Error Message for Key Data Missing | 143 |
| Figure 205 | Inactivate Selected Event Code (EC) Screens for Given Procedure Code | 143 |
| Figure 206 | Inactivate Selected Event Code (EC) Screens with CPT Code Selected | 144 |
| Figure 207 | Confirmation Prompt | 144 |
| Figure 208 | List of EC Screens That Were Inactivated | 145 |
| Figure 209 | Non-Licensed Provider Maintenance Screen | 146 |
| Figure 210 | Adding a Non-Licensed Provider | 146 |
| Figure 211 | Non-Licensed Provider Selection for DSS Units that Do Not Send to PCE | 147 |
| Figure 212 | Removing a Non-Licensed Provider | 147 |
| Figure 213 | Desktop Context Menu - Change Screen Resolution | 148 |
| Figure 214 | Windows Screen Resolution Settings | 149 |
| Figure 215 | Selecting Recommended Resolution for Windows Display | 149 |
| Figure 216 | Example Email Message when an ECS Patch is Released | C-1 |
| Figure 217 | Example Email Message for Updated National Procedure Codes Patch | C-2 |
| Figure 218 | Example of Event Code Screens to Review Message | C-3 |
| Figure 219 | Example 1 – ECS User Terminated Email Message | C-4 |
| Figure 220 | Example 2 – ECS User Terminated Email Message | C-4 |
1 Introduction

The Event Capture System (ECS) Graphical User Interface (GUI) User’s Guide provides instructions for using the Event Capture options within the GUI setting. The target audience for this manual includes Event Capture managers, Automatic Data Processing Application Coordinators (ADPACs) and other software users.

The GUI provides a consistent, event-driven, Windows® style user interface for Event Capture.

The Event Capture software provides a mechanism to track and account for procedures and delivered services that other Veterans Health Information Systems and Technology Architecture (VistA) packages do not handle. The procedures and services tracked through Event Capture are associated with the following:

- The patient to whom they were delivered
- The provider requesting the service or procedure
- The Decision Support System (DSS) Unit responsible for delivering the service

DSS Units typically represent the smallest identifiable work unit in a clinical service at a medical center. Veterans Affairs Medical Centers (VAMCs) define the DSS Units. A DSS Unit can represent any of the following:

- An entire service
- A section of a service
- A small section within a section
- A medical equipment item used in patient procedures

The user must define the following items for every DSS Unit:

- **Service**: The service associated with the DSS Unit
- **Cost Center**: The fiscal identifier for the service using the particular DSS Unit (Cost Centers are defined in detail in the MP4-Part V Appendix B of the Fiscal Service Cost Manuals)
- **Medical Specialty**: The specialty section associated with the DSS Unit

1.1 Purpose

The ECS GUI User’s Guide is intended for use as an instructional guide to using the Event Capture software. The user can use this manual in conjunction with the Event Capture GUI online help option.

Screen displays may vary among different sites, and the data may not appear on the terminal exactly as shown in this manual. Although screens are subject to modification, the major menu options as they appear in this manual are fixed and are not subject to modification (except by the package developer).

1.2 Document Orientation

The following sub-paragraphs provide general information about how to use this document.
1.2.1 Organization of the Guide

This document is organized into the following major sections:

**Introduction** – This section provides a brief description of the purpose of the guide and an orientation into the document’s structure and use.

**System Summary** – This section provides a general description of the system written in non-technical terminology, the purpose for which the system is intended, the system configuration, data flows, user access and continuity of operations.

**Getting Started** – This section provides a general walkthrough of the system from initiation through exit. The logical arrangement of the information enables functional personnel to understand the sequence and flow of the system.

**Using the Software** – This section serves as reference to the user, covering vital aspects of this tool.

**Data Entry** – ECS is programmed to allow the users to enter records and edit specific fields.

**Spreadsheet** – ECS allows the uploading of data through spreadsheets. There are two types of spreadsheets: Regular Spreadsheets and State Home Spreadsheets. Information for both types is included in this guide.

**Reports** – ECS Reports are designed according to Managerial Cost Accounting Office (MCAO) specifications. Users have the option of previewing the report, exporting the report into an Excel spreadsheet, or printing a hardcopy. Some reports are only accessible to users with the manager security key.

**Management Menu** – This option accesses the menus needed for management of the Event Capture software. It includes, but is not limited to, allocation of DSS Units, assignment of users to DSS units, addition of local procedures and categories, and the creation of Event Code Screens.

**Troubleshooting** – This section provides general troubleshooting advice on issues encountered by users.

**Acronyms and Abbreviations** – This section provides the user with a list of abbreviations and acronyms used throughout the document.

**Glossary** – This section provides the user with definitions of terms used throughout the document.

**Index** – Index of major topics of interest.

1.2.2 Assumptions

This guide was written with the following assumed experience/skills of the audience:

- User has basic knowledge of the operating system (such as the use of commands, menu options, and navigation tools).
- User has been provided the appropriate active roles, menus, and security keys required for ECS.
- User is using ECS to perform his/her job.
- User has validated access to ECS.
- User has completed any prerequisite training.
1.2.3 Disclaimers

The following disclaimers apply to all Department of Veterans Affairs (VA) user documentation.

1.2.3.1 Software Disclaimer

This software was developed at the VA by employees of the Federal Government in the course of their official duties. Pursuant to title 17 Section 105 of the United States Code, this software is not subject to copyright protection and is in the public domain. VA assumes no responsibility whatsoever for its use by other parties, and makes no guarantees, expressed or implied, about its quality, reliability, or any other characteristic. We would appreciate acknowledgement if the software is used. This software can be redistributed and/or modified freely provided that any derivative works bear some notice that they are derived from it, and any modified versions bear some notice that they have been modified.

1.2.3.2 Documentation Disclaimer

The appearance of external hyperlink references in this guide does not constitute endorsement by the VA of this website or the information, products, or services contained therein. The VA does not exercise any editorial control over the information you may find at these locations. Such links are provided and are consistent with the stated purpose of the VA.

1.2.4 Documentation Conventions

To avoid displaying sensitive information regarding patients and staff, the examples in this guide contain pseudonyms or scrambled data instead of real names. Patients and staff will be referred to as “ECPATIENT, ONE,” “AAECPROVIDER, ONE,” or “USER, ONE.” Scrambled data are a series of random letters that replace a real name (e.g., “AAADY, JWHTRE”). Likewise, real social security numbers (SSNs), real addresses, and other personal identifiers are not used.

1.2.5 References and Resources

The documentation for Event Capture v2.0 includes the following:

- Event Capture Deployment, Installation, Rollback, and Back-Out Guide
- Event Capture Patch Description
- Event Capture Technical Manual
- Event Capture GUI Version Description Document

These documents can be found on the VA Software Document Library (VDL) website.

Patch information and documentation is also available online at the MCA Learning Community for Event Capture website.

1.3 National Service Desk and Organizational Contacts

The three tiers of support documented herein are intended to restore normal service operation as quickly as possible and minimize the adverse impact on business operations, ensuring that the best possible levels of service quality and availability are maintained.

Table 1 lists organizational contacts needed by site users for troubleshooting purposes. Support contacts are listed by name of service responsible to fix the problem, description of the incident escalation, associated tier level, and contact information (email and phone number).
<table>
<thead>
<tr>
<th>Name</th>
<th>Role</th>
<th>Org</th>
<th>Contact Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local ECS Package Manager</td>
<td>Tier 0 Support</td>
<td>Veterans Health Administration</td>
<td>ECS Package Manager/Site Dependent</td>
</tr>
<tr>
<td>Local Managerial Cost</td>
<td>Tier 0 Support</td>
<td>VHA</td>
<td>MCAO Phone List</td>
</tr>
<tr>
<td>Accounting (MCA) VISN</td>
<td></td>
<td></td>
<td>Site Dependent</td>
</tr>
<tr>
<td>Coordinator</td>
<td></td>
<td></td>
<td>MCAO Phone List</td>
</tr>
<tr>
<td>OI&amp;T National Service Desk</td>
<td>Tier 1 Support</td>
<td>OI&amp;T</td>
<td><a href="mailto:Nationalservicedeskanr@va.gov">Nationalservicedeskanr@va.gov</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1-855-673-4357</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Incident Management Automated Notification Reporting (ANR) Tool</td>
</tr>
<tr>
<td>Health Services Portfolio</td>
<td>Tier 2 Support</td>
<td>VHA</td>
<td><a href="mailto:Nationalservicedeskanr@va.gov">Nationalservicedeskanr@va.gov</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1-855-673-4357</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Incident Management ANR Tool</td>
</tr>
<tr>
<td>VistA Maintenance Management</td>
<td>Tier 3 Application</td>
<td>OI&amp;T</td>
<td><a href="mailto:OITPDVistAMaintenanceManagementSystems@va.gov">OITPDVistAMaintenanceManagementSystems@va.gov</a></td>
</tr>
<tr>
<td>Systems</td>
<td>Support</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


2 System Summary

ECS is a VistA Class I workload reporting system supporting operations of the VA MCAO. There are several VHA national programs mandating utilization of ECS in place of, or to augment, other workload capture information systems. For example, ECS is leveraged when programs cannot report workload in the form of Current Procedural Terminology (CPT) codes. Other times, ECS allows for more precise workload capture and reporting than otherwise possible through another VistA system.

Event Capture with all patches installed provides the following functions:

- Allows each VAMC to utilize the software for its own resource/costing needs
- Implements DSS Units
- Assigns user access
- Allows single and batch data entry for patient procedures
- Generates reports for workload and other statistical tracking
- Provides a graphical user interface (GUI) to the ECS application
- Allows user to upload patient encounter data to Event Capture from a spreadsheet
- Allows user to switch between Computerized Patient Record System (CPRS) and ECS without having to log back into the Event Capture (EC) GUI.exe

2.1 System Configuration

Please refer to the Event Capture Technical Manual for details related to system and site configuration.

2.2 Data Flows

ECS captures both inpatient and outpatient workload and uses VHA-wide standardized procedures which help aid benchmarking and workload analysis. ECS captures basic resource utilization data, creates monthly extracts, and electronically transmits to DSS, Patient Care Encounter (PCE), and billing offices for processing which facilitates workload analysis, cost analysis, and transmission of billing.

Figure 1 represents the ECS data flow.
2.3 User Access Levels

Security keys are assigned in VistA using the option Key Management main menu and then choosing the submenu Allocation of Security Keys.

ECS provides the following security key options for user access:

- ECMGR: Gives a user access to the ECS Management Menu – only for Event Capture managers
- ECALLU: Gives a user access to all DSS Units (super user). This key should be assigned only to those managing the software (i.e., holders of the ECMGR key)
- ECNORPT: Restricts the user from accessing Event Capture reports
- ECSPSH: Gives a user access to upload data from a spreadsheet (required for State Home Spreadsheet upload)

2.4 Continuity of Operations

Each site has a backup emergency plan in place in the event that the system goes down.

2.5 Section 508 Compliance

Section 508 of the Rehabilitation Act Amendments of 1998 requires that when Federal agencies develop, procure, maintain, or use electronic and information technology, they shall ensure that the electronic and information technology enables persons with disabilities to have access to, and use of, information and data that is comparable to the access to and use of information and data by persons who are not individuals with disabilities, unless an undue burden would be imposed on the agency.

The Section 508 Accessibility Testing and Training Center (T&TC) was consulted and modifications to the GUI have been made to meet the requirements for Section 508 compliance. Event Capture was modified to enable screen readers to accurately interpret information on the screens. As a result, some buttons and boxes have been moved, replaced, or renamed, and some screen titles have been modified.

For more information on the VA Section 508 compliance efforts, please visit the Section 508 website.

2.5.1 Screen Readers

ECS has been evaluated for the accessibility of application content with multiple commercial screen readers. ECS has been tested to ensure all screens work properly when a screen reader is active.
3 Getting Started

Event Capture must be set up by using the options in the Event Capture Management Menu before any data can be entered. Access to this menu should be restricted to the ADPAC and his/her designees. The Event Capture ADPAC should use the following steps as a guide for setting up the Event Capture software.

Step 1. Select security keys.

- See Section 2.3 of this document for a description of ECS security keys.

Step 2. Select required VistA settings.

- Users must be assigned the EC GUI CONTEXT VistA menu options in order for the ECS GUI to work.

Step 3. Create an Event Capture Location.

- Create a location using the Location - Update Location Information option.

  Notes:
  - The selected location must be in the INSTITUTION file (#4).
  - At least one location must exist before DSS Units can be established.

Step 4. Establish DSS Units for each service.

- Contact each service for a list of its DSS Units, the names of its Event Capture users and the DSS Units for which they will enter data, and for individual product resource tracking needs.
- Use the DSS Unit - Add or Update DSS Units option to establish DSS Units for each service.

  Note:
  - At least one DSS Unit must exist before Event Code Screens can be created.

Step 5. Assign user access to specific DSS Units.

- Use the Access by User - Grant Access to DSS Units by User option to assign user access to specific DSS Units for the users identified in Step 4.
- Assign the ECALLU security key only to those users who should have access to all DSS Units.

  Notes:
  - Users must have access to DSS Units before they can begin entering data.
  - Use the Access by User – Grant Access to DSS Units by User option to remove user access for a specific DSS Unit. Users with the ECALLU security key cannot be denied access to DSS Units.

Step 6. Create Categories.

- Use the Category - Add or Update Categories option to create categories before the user sets up Event Code Screens.

  Notes:
  - Creating categories is optional.
  - After completion of this step, the Category Report option on the Reports Menu can be used to print a report of the site’s categories.
Step 7. Create or edit local procedures in the EC NATIONAL PROCEDURE file (#725).

- Use the Procedure - Add or Update Local Procedures option to enter new, or edit existing, local procedures in the EC NATIONAL PROCEDURE file (#725).
- Adding local procedures is optional and not encouraged.

**Notes:**
- Before starting this step, use the National/Local Procedure Report option on the Reports Menu to print a list of procedures with their associated CPT codes. This report can be quite lengthy if it includes national procedures, so it should be queued to print to a device during non-peak hours.
- An associated CPT code must be entered to pass local procedures to PCE.
- Use this option to edit, but not delete, existing local procedures and to select an associated CPT code if this workload data should be sent to PCE.

Step 8. Use the Event Code Screen - Add or Update Event Code Screens option to:

- Create an Event Code Screen for each procedure tracked in the Event Capture software.
- Enter or edit an optional active associated clinic for DSS Units that are marked to send data to PCE. If an Associated Clinic has non-conforming stop codes, the clinic will not be selectable.
- Enter or edit an optional procedure Synonym.
- Set Ask Reasons? Radio button to Yes or No.
- Enter or edit procedure default Volume.

**Note:**
- An Event Code Screen for the procedure must be created before it can be used for data entry.

Step 9. Optional: Print the Event Code Screens Sorted by DSS Units

- Use the Print Category and Procedure Summary (Report) option on the Reports Menu to print the Event Code Screens sorted by DSS Units.

**Note:**
- Data entry clerks might find the output generated by this report useful as a procedure reference guide.

Step 10. Event Capture set up is complete.

- Services can now enter data using the Data Entry options and provide summary reports using the Reports options.

### 3.1 Logging On

Event Capture is accessed through a desktop shortcut that points to the location of the EC GUI application (Figure 2). If the shortcut does not appear, refer to the Installation Guide for Event Capture, or ask the local support staff for assistance.

**Figure 2: ECS GUI Icon**

Step 1. Double-click the EC GUI shortcut to launch the application.
Once Event Capture is launched, there are 4 methods of providing user authentication:

- Single Sign-On (SSO) through CPRS
- Clinical Context Object Workgroup (CCOW)
- Personal Identification Verification (PIV) with Two-Factor Authentication (2FA)
- Access and Verify codes

### 3.1.1 Authentication via CPRS SSO

ECS user authentication can be achieved via SSO through CPRS. This design is intended to increase the use of Event Capture by clinicians currently using CPRS.

The interface between CPRS and Event Capture enables users to access Event Capture from within CPRS through single sign-on. This is achieved by selecting the Event Capture Interface in the CPRS Tool Menu which allows the user to enter Event Capture patient procedures. When accessing Event Capture in this way, both user and patient context are maintained. This CPRS feature requires set up by the local Information Resource Manager (IRM) and/or the Clinical Application Coordinator.

### 3.1.2 Authentication via CCOW SSO

Event Capture includes CCOW SSO capability. If a user is signed onto another CCOW SSO-enabled system, launching Event Capture will not require the user to re-enter system Access and Verify codes. Likewise, if CCOW is enabled in Event Capture, other CCOW SSO compliant applications can use the current user’s authentication credentials from Event Capture. The status of the CCOW SSO is shown via an icon on a panel in the upper-right hand corner of the Main Menu (Figure 3). The hover help will display “Clinical Link On” if Event Capture was accessed with CCOW SSO enabled or “Clinical Link Off” if it was not. In addition, the icon on the panel will indicate current CCOW status. The CCOW feature requires set up by the local IRM.

![Figure 3: Event Capture CCOW Status](image)

### 3.1.3 Authentication via Personal Identification Verification (PIV)

2FA adds an additional layer of security beyond a traditional username and password combination. Event Capture can obtain credentials from a PIV card and Personal Identification Number (PIN) combination. When Event Capture is first launched, it will attempt to use a PIV card for authentication.

**Step 1. Select your PIV card certificate (Figure 4):**
Step 2. Enter the PIN and press the OK button (Figure 5)

If PIV authentication is successful, the System Use Notification will appear (Figure 6). Press the OK button to complete the login process.
If PIV authentication fails, the prompt for Access and Verify codes will appear.

### 3.1.4 Authentication via Access and Verify Codes

If PIV authentication fails, authentication will revert to the traditional Access and Verify code method of VistA login (Figure 7). When this happens, enter valid Access and Verify codes, and click the **OK** button.

![Figure 7: VistA Login Screen](image)
3.2 Event Capture Main Menu

The Event Capture software contains four menus (Figure 8). The user must hold the ECSPSH security key to have access to the Spreadsheet option, and the ECMGR security key to have access to the Management Menu functions. Users without the ECMGR security key will have fewer reports available for selection than users with the ECMGR security key. Users with the ECNORPT security key will not have access to the Reports option (Figure 9).

![Figure 8: Main Menu for Event Capture](image)

![Figure 9: Main Menu for Users with the ECNORPT Security Key](image)

3.2.1 Icon Shortcuts

A toolbar is available with icons to access frequently used options quickly from the Main Menu in Event Capture (Figure 10).
Before the User Starts

- Only users without the ECNORPT security key will see the Go to Reports Menu toolbar option.
- Only users with the ECMGR security key will see the Go to the Management Menu toolbar option.
- Only users with the ECMGR security key will see the Delete Test Patient Data toolbar option.

What the User Will See

- Under the menu bar on the ECS Main Menu, the toolbar presents the most frequently used options (Figure 10).
- The number of toolbar options visible will depend upon the individual user’s security key assignment.

![Figure 10: Icon Shortcuts](image)

**Figure 10: Icon Shortcuts**

- Close the Application
- Go to the Data Entry Menu
- Go to the Spreadsheet Menu
- Go to the Reports Menu
- Go to the Management Menu
- Delete Test Patient Data
- Topic Help

### 3.2.2 Menu Bar

The Event Capture menu bar (Refer to Figure 11) enables the user to access shortcut commands.

![Figure 11: Main Menu Bar](image)

Before the User Starts

- Only users without the ECNORPT security key will see the Reports Menu option under the Function Menu.
- Only users with the ECMGR security key will see the Management Menu option under the Function Menu.
- Only users with the ECMGR security key will see the Delete Test Patient Data option under the Function Menu.

What the User Will See

- Under the Event Capture title bar on the ECS Main Menu, the menu bar presents the top-level commands (Figure 11).
- The File menu item enables the user to Exit the application.
- The Function menu item on the main window provides access to
  - Data Entry
  - Spreadsheet (if the user has the proper security key)
• Reports (if the user has the proper security key)
• Management Menu (if the user has the proper security key)
• Delete Test Patient Data (if the user has the proper security key)
• The View menu item enables the user to show or hide the Toolbar and Status Bar.
• The Help menu item provides topic-specific help, or information about the Event Capture system.

Figure 12 displays the menu bar options with expanded menus.

![Figure 12: Main Menu Bar with Menus Expanded](image)

### 3.2.3 Delete Test Patient Data

The Main Menu provides management users the ability to delete test patient data. Running this option ensures that reports will not contain test patient data.

**Before the User Starts**

- Only users with the ECMGR security key will have access to the Delete Test Patient Data option.
- The Delete Test Patient Data option is only available on the ECS Main Menu.
- Test patient data entered for DSS Units CH103-109 is excluded from deletion when running this option.

**What the User Will See**

- After selecting the Delete Test Patient Data option from the ECS Main Menu (menu bar or toolbar), a Delete Test Patient dialog box will display (Figure 13).
- The Delete Test Patient dialog box informs the user to which account he or she is connected, the date and time the option was last run (if available) and the name of the person that last performed the option. The dialog also contains a warning message informing the user that deletion cannot be undone.

![Figure 13: Delete Test Patient Data Dialog Box](image)
3.3 Menu Bar for Specific Functions

The menu bar for the four ECS functions are described in the following subsections.

3.3.1 Data Entry Menu Bar

The Data Entry menu bar consists of the File, Edit, View, and Help menus (Figure 14).

![Figure 14: Data Entry Menu Bar Options](image)

- The File menu item provides the option for the user to exit the window.
- The Edit menu item provides access to Data Entry by Patient, Data Entry by Procedure, and Multiple/Multiple functions.
- The View menu item enables the user to show or hide the Toolbar and Status Bar.
- The Help menu item provides topic-specific help, or information about the Event Capture system.

Figure 15 shows the Data Entry menu bar options with the expanded menus.

![Figure 15: Data Entry with Menus Expanded](image)

3.3.2 Spreadsheet Menu Bar

The Spreadsheet menu bar consists of the File, Edit, EC Upload, Spreadsheet Options (if the user has the proper security key), and Help menus (Figure 16).

![Figure 16: Spreadsheet Menu Bar Options](image)

- The File menu item enables the user to Exit the window as well as Open Spreadsheet, Open State Home Spreadsheet, Close, Save, Save As, and Print a file.
- The Edit menu item provides access to Cut, Copy, Paste, Insert Row, and Delete Row functions.
- The EC Upload menu item enables the user to Upload Records to VistA.
• The Spreadsheet Options menu item enables the user to Change Column Headers or Change Duplicate Threshold.
• The Help menu item provides topic-specific help, or information about the Event Capture system.

Figure 17 shows the Spreadsheet menu bar options with the expanded menus.

![Figure 17: Spreadsheet Menu Bar with Menus Expanded](image)

### 3.3.3 Reports Menu Bar

The Reports menu bar consists of the File, View, and Help menus (Figure 18).

![Figure 18: Reports Menu Bar Options](image)

• The File menu item enables the user to Exit the window.
• The View menu item enables the user to show or hide the Toolbar and Status Bar.
• The Help menu item provides topic-specific help, or information about the Event Capture system.

Figure 19 shows the Reports menu bar options with the expanded menus.

![Figure 19: Reports Menu with Menus Expanded](image)

### 3.3.4 Management Menu Bars

The Management Menu bar consists of the File, Table, View, and Help menus (Figure 20).
• The File menu item enables the user to Exit the window.
• The Table menu item provides access to Location, DSS Unit, Access by User, Category, Procedure, Reason, Event Code Screen, Inactivate EC Screen, and Providers functions.
• The View menu item enables the user to show or hide the Toolbar and Status Bar.
• The Help menu item provides topic-specific help, or information about the Event Capture system.

Figure 21 shows the expanded Management Menu bar options with expanded menus.

3.4 Changing User ID and Password
In the event that PIV authentication is unavailable, users will need to use VistA access and verify codes to access ECS. To request changes to assigned access and verify codes, please contact the local Information Resource Manager (IRM).

3.5 Exit System
From the main Event Capture menu, click the Exit button to exit the Event Capture GUI. Alternatively, from the same screen, users can go to File > Exit, or click the Close window button in the top-right corner of the screen.

3.6 Caveats and Exceptions
On all ECS GUI screens, the previous Location entry will be saved and used as the default on subsequent Location fields.

3.7 Online Documentation
Online help is available throughout the entire ECS GUI. To obtain online information for any screen, click the question mark button located on the toolbar or at the bottom-right corner of the screen, click the
Topic Help button. The information provided in the help menus corresponds to the information that is in this user’s guide (Figure 22).

To obtain online information for a field, select that field and then press the <F1> key.

Figure 22: Online Help Screen

3.8 Timeout Feature

Event Capture includes a timeout feature consistent with CPRS. A countdown screen will display a warning of the pending timeout of the application when the Event Capture application is idle for a user-defined amount of time. If the user takes no action, the application will close. Click the “Do not close Event Capture” button to stay connected (Figure 23).

Figure 23: Event Capture Timeout Screen

The amount of time for the timeout feature is user-defined at the application server level.
4 Using the Software

The following subsections provide instructions on how to use ECS to perform tasks and functions in each of the four main areas: Data Entry, Spreadsheets, Reports, and Management Menu.

4.1 Data Entry Menu

The Data Entry Menu offers three options (Figure 24):

- Data Entry by Patient – Enter/Edit Patient Procedures
- Data Entry by Procedure – Batch (Same Procedure, Multiple Patients)
- Multiple Dates/Procs – Multiple Dates / Multiple Procedures

4.1.1 Data Entry by Patient

The Data Entry by Patient allows the user to enter a single procedure for one patient, edit an existing patient procedure, or delete an existing patient procedure.

Before the User Starts

- Event Code Screens must be defined before entering any Event Capture data.

What the User Will See

- After selecting the Data Entry by Patient option, the Enter/Edit Patient Procedures screen will display (Figure 25), allowing the user to search by the Location, DSS Unit, Procedure Date Range, and Patient Identifier.
- After entering the desired selection criteria and clicking the Search button, any existing procedures for the selected patient will appear (Figure 27).
4.1.1.1 Enter/Edit Patient Procedures Screen

To use the Enter/Edit Patient Procedures screen:

Step 1. Select a Location.

- If there is only one Location set up in ECS, the Location on the screen will default to that value.
- If there is more than one Location set up in ECS, the Location on the screen will default to the last Location used. To change the Location, choose a Location from the dropdown list.

Step 2. Select a DSS Unit.

- If one DSS Unit is defined in the Management Menu, or if only one DSS Unit is assigned to the user, that DSS Unit value will default.
- If only one DSS Unit is assigned to the user, it will be the default selection. If more than one DSS Unit is assigned to the user, choose a DSS Unit from the dropdown list of accessible DSS Units.
- The user can add, edit, or delete any patient procedure for the selected DSS Unit.
- To gain access to a DSS Unit, go to the Management Menu and choose the DSS Unit - Add or Update DSS Units function to add the unit to the dropdown list. The ECMGR key is required.

Step 3. Select a Date Range.

- The Procedure Date Range (from/through) will default to the system date. These fields may be edited by typing in a date (dd MMM yyyy) or by using the calendar dropdown (Figure 26).

Note:

- Date validation will prevent selecting a date in the future, or displaying a Procedure From date later than the Procedures Through date.
Step 4. Use the Patient Identifier field to select a patient.

- Enter one of the following:
  - Patient Name (whole or partial, last name first)
  - Social Security Number (SSN)
  - Last four digits of the Patient Social Security Number
  - First character of Last Name plus the last four digits of the SSN with no spaces
- Press <Enter> on the keyboard or click the Search button.
- Choose from the list of patients displayed.

Step 5. View the Patient Procedures.

- Once the previous steps are complete, the bottom section of the window will display the patient procedures in chronological order for the selected search criteria (Figure 27). Each record will display the Category, Procedure, Date/Time, Volume, Associated Clinic, Ordering Section, Primary Diagnosis, and Primary Provider.

Notes:

- Click the field header to sort the data in a different order.
- The Close, Add, and Topic Help buttons are always enabled. If patient procedures exist, the Update and Delete buttons will be enabled as well.
- Clicking on a row will highlight the patient procedure, effectively selecting that row as a candidate for updating or deleting.
Step 6. Complete data entry.

Step 7. Click the Add button to enter a new patient procedure.

Step 8. Click the Update button to display the patient procedure on the Edit Patient Procedure (Detail) screen.

Step 9. Click the Delete button to delete the patient procedure from the file.

4.1.1.2 Recent Visits Screen

To see the Recent Visits screen (Figure 28):

Step 1. On the Enter/Edit Patient Procedures screen, click the Add button to enter a new patient procedure.

**Note:**
- If the selected DSS Unit is set to send to PCE and recent visits exist, the Recent Visits screen will be displayed after clicking the Add button.
Step 2. Selection options on the Recent Visits screen.

- On the Recent Visits screen, the user can choose one of three options: OK, Ignore, or Cancel.
  - **OK**: Select the appropriate Appointment/Encounter from the Recent Visits. Click the **OK** button to close the screen. The Add Patient Procedure screen will display with the Procedure Date/Time and Associated Clinic fields populated and not modifiable, based on the Appointment/Encounter selected on the Recent Visits screen (Figure 29). Enter the procedure(s), answer classification questions as they pertain to that visit, and enter diagnoses, provider, and other pertinent fields if required (reasons, ordering section, and/or modifiers).
  - **Ignore**: Click the **Ignore** button on the Recent Visits screen to go to the Add Patient Procedure screen to enter information for all fields.
  - **Cancel**: Click the **Cancel** button to close the Recent Visits screen and return to the Enter/Edit Patient Procedures screen.

Notes:

- One can select current day encounters from the Recent Visits, even if they occur after the current time. However, appointments and encounters that occur after the end of the current day will not be available for selection.
- If the Associated Clinic for the selected record is no longer active, clicking the **OK** button will result in the display of the Error: Invalid Associated Clinic message dialog (Figure 30). The message dialog lists only active Associated Clinics.
- To update the record, select an active clinic from the list and then click the **OK** button.
- Click the **Cancel** button to open the record and the Associated Clinic field will be blank.
Figure 29: Add Patient Procedure Detail Screen

Figure 30: Error: Invalid Associated Clinic Message Dialog
4.1.1.3 Add Information to the Add Patient Procedure or Edit Patient Procedure Screen

The user can enter or edit patient procedures performed on an individual patient.

The following instructions and example assume that a user is entering a new procedure for a specified patient, and that the specified DSS Unit transmits data to PCE.

**Step 1. Select a Category.**

- If the Allow Category Use field in the DSS Unit Management set up is set to NO, then the Category field will be blank and disabled.
- If the Category field is defined for the specified DSS Unit, that Category will be the default value.

**Step 2. Select the Procedure Date and Time.**

- The Procedure Date and Time field is not editable if a recent visit was selected on the Recent Visits screen.
- Typing “N” and then pressing <Enter> (instead of clicking the button) will bypass the Select Date/Time dialog box (Figure 31).
- Clicking the Now button in the dialog box will enter the current system date and time.
- When the Midnight button is clicked, “23:59” is displayed for the time on the date selected.
- Until a valid date and time are selected, fields after the Procedure Date and Time field are not visible. Once a valid date and time are selected, the remaining fields become visible and available for input.

**Figure 31: Select Date/Time Dialog Box**

![Select Date/Time Dialog Box](image)

**Step 3. Select an Eligibility Code for this procedure.**

- If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure.
- The primary Eligibility Code displays as the default.

**Step 4. Select a Procedure Name.**

- Select a Procedure from the dropdown list.

**Step 5. Enter the Volume for the procedure.**

**Step 6. If applicable, the CPT Modifiers section will be enabled.**
• Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will show.
• Choose a modifier from the Modifiers Available list and click Include.
• Repeat as needed.
• To remove a modifier, choose it from the Modifiers Selected list and click Exclude.
• Press <CTRL-Click> to select multiple modifiers at one time.

Step 7. If applicable, the Reasons field will be enabled.

• The user can enter up to three reasons.
• Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
• Reasons appear alphabetically in the dropdown.
• Once selected, a reason will not appear in the dropdown list for remaining reason fields.
• A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason, or enter different letter(s).

Step 8. If applicable, the mandatory classification questions section will be enabled.

• Select YES only if the treatment received relates to that classification.
• Press the <F1> key while in the Service Connected field to display a message dialog containing the patient's service connection and any rated disabilities (Figure 32).

Figure 32: Service Connection and Rated Disabilities Screen

Step 9. Select the Ordering Section.

Step 10. Select the Associated Clinic (if not already populated from the Recent Visits screen).

Step 11. Select the associated diagnosis code for the procedure.

• Use the Primary field to enter one of the following:
  – International Classification of Diseases (ICD) code (whole or partial)
  – Diagnosis Name (whole or partial)
• Click the Search button.
• Select from the resulting dropdown list.
• Repeat as needed to select the secondary diagnosis codes.
Step 12. **Select the providers of the services. Use the Providers Available text box to enter the following:**

- Provider name (full or partial, last name first).
- Select the provider from the resulting dropdown list and click Include.
- To remove a provider, select from the Providers Selected list and click Exclude.

Step 13. **Clicking the Add button files the current procedure and clears the fields, allowing for input of additional procedures for the selected patient.**

Step 14. **Click the OK button to file the current procedure and return to the Enter Patient Procedure screen.**

Step 15. **Click the Cancel button to return to the Enter Patient Procedure screen without saving the above entries.**

**Notes:**

- If the record transmits to PCE based on the DSS Unit on Management Menu set up, then all fields will be required.
- If the record does not transmit to PCE based on the DSS Unit on Management Menu set up, then the Associated Clinic and the four Secondary Diagnosis fields will be disabled.
- Occasion Of Service records will not require answers to Classification questions, and will not require any diagnosis values.
- Press the <F1> key while in any field to open a dialog box displaying a help message.

### 4.1.1.4 Add a Patient Procedure

The following instructions and example assume that a user is entering a patient procedure for a specified patient and that the specified DSS Unit transmits data to PCE.

**Step 1.** On the main Event Capture menu, select Data Entry.

**Step 2.** On the Data Entry Menu, select Data Entry by Patient.

- The Enter/Edit Patient Procedures screen appears (Figure 33).

**Step 3.** Select the Location and DSS Unit.

**Step 4.** Allow the Procedure Date Range to default to today.

**Step 5.** Select a Patient.
Figure 33: Enter/Edit Patient Procedures Screen

Step 6.  Click Add.

Step 7.  If the DSS Unit is set to send to PCE, the Recent Visits screen will appear (Figure 34). Select a scheduled appointment and click OK.

Figure 34: Recent Visits Screen

Step 8.  Complete the procedure-related fields on the Add Patient Procedure detail screen (Figure 35) according to the field-by-field instructions given in Section 4.1.1.3.
Step 9. Click Add to file the record and clear the fields, allowing for input of another procedure for this patient.

Step 10. Click the OK button to save the record and return to the Enter/Edit Patient Procedures screen.

Step 11. The Enter/Edit Patient Procedures screen displays any existing procedures for this patient (Figure 36).
Figure 36: Enter/Edit Patient Procedures with New Procedure Added

Step 12. Click Close to return to the Data Entry menu.

4.1.1.5 Edit a Patient Procedure

Step 1. On the main Event Capture menu, select Data Entry.
Step 2. On the Data Entry Menu, select Data Entry by Patient.
Step 3. The Enter/Edit Patient Procedures screen appears (Figure 37).
Step 4. Select the Location and DSS Unit.

Step 5. Enter a Procedure Date Range by using the calendar dropdowns.
- The date fields default to the current system date.


Step 7. The lower portion of the screen displays the procedure(s) for the selected patient and the DSS Unit within the date range.

Step 8. Select a procedure and click the Update button.
- The Edit Patient Procedure screen appears (Figure 38).
Figure 38: Edit Patient Procedure Screen

Complete the procedure-related fields on the Edit Patient Procedure detail screen according to the field-by-field instructions given in Section 4.1.1.3.

Click Add to file the record and clear the fields, allowing for input of another procedure for this patient.

Click the OK button to save the record and return to the Enter/Edit Patient Procedures screen.

The Enter/Edit Patient Procedures screen displays the procedure(s) (Figure 39) entered for this patient.

Click Close to return to the Data Entry menu.
4.1.1.6 Delete a Patient Procedure

This section instructs the user on how to delete a Patient Procedure.

Step 1. On the main menu, select Data Entry.

Step 2. On the Data Entry Menu, select Data Entry by Patient.

- The Enter/Edit Patient Procedures summary screen appears (Figure 39).

   Figure 39: Enter/Edit Patient Procedures Screen

   ![Enter/Edit Patient Procedures Screen]

Step 3. Select the Location and DSS Unit.

Step 4. Enter a procedure date range by using the calendar dropdowns.

- The date fields default to the current system date.

Step 5. Select a patient.

Step 6. The lower portion of the screen displays the procedure(s) for the selected patient and the DSS Unit within the date range.

Step 7. Choose a procedure and click the Delete button.

- A confirmation message appears (Figure 40).

   Figure 40: Procedure Deleted Confirmation Dialog

   ![Confirmation Dialog]
• Click the Yes button on the confirmation message dialog, and an Information message dialog appears to show the selected procedure was deleted for the patient (Figure 41). Click the OK button to return to the Enter/Edit Patient Procedures screen.

• Click the No button on the confirmation message dialog to return to the Enter/Edit Patient Procedures screen without deleting the procedure.

![Figure 41: Information Message](image)

• The screen will refresh to show the remaining procedures entered for this patient (Figure 42).

![Figure 42: Enter/Edit Patient Procedures Screen with Procedure Deleted](image)

Step 8. Click the Close button to return to the Data Entry menu.

4.1.2 Data Entry by Procedure

The Data Entry by Procedure option allows the user to enter or edit the same procedure for multiple patients.

Before the User Starts

• Event Code Screens must be defined before entering any Event Capture data.

What the User Will See
• After selecting Data Entry by Procedure, the Same Procedure, Multiple Patients screen will display (Figure 43).
• The left side of the screen contains information for the procedure that the system will use for all patients. (Note: The user will enter the procedure information only one time.)
• The right side of the screen identifies each patient. The user will complete this section for each patient. Click Add to file the data and clear the fields to enter data for the next patient.
• The View button displays a listing of all patients entered for this procedure in this session.

Figure 43: Same Procedure, Multiple Patients Screen

4.1.2.1 Add a Procedure for Multiple Patients

The following instructions and example assume that the user wants the specified DSS Unit to send data to PCE.

Step 1. Select a Location.

• If there is only one Location set up for the Event Capture System, the Location on the screen will default to that value.
• If there is more than one Event Capture Location set up, the Location will default to the last Location used. To change the Location, choose a Location from the dropdown list of available Event Capture Locations.

Step 2. Select a DSS Unit.

• If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the user, that DSS Unit will be the default value.
• If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit from a dropdown list of accessible DSS Units.
To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add or Update DSS Units function to add the unit to the dropdown list.

**Step 3. Select a Category.**

- If only one category is defined for the specified DSS Unit, that category will be the default.

**Step 4. Select the Procedure Date and Time.**

- Typing "N" and then pressing <Enter> in the field (instead of clicking the button) will bypass the Select Date/Time dialog (Figure 44), or clicking the Now button on the Date/Time dialog will enter the current system date and time. When the Midnight button is clicked, "23:59" is displayed for the time on the date selected.

- Until a valid date and time are selected, fields after the Procedure Date and Time field are not visible. Once a valid date and time are selected, the remaining fields become visible and available for input.

**Figure 44: Select Date/Time Dialog**

![Select Date/Time Dialog](image)

**Step 5. Select a Procedure Name.**

- Select a procedure from the dropdown list.

**Step 6. If applicable, the Reasons field will be enabled.**

- The user can enter up to three reasons.
- Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
- Reasons appear alphabetically in the dropdown.
- A reason will not appear in the dropdown list for remaining reason fields as an option once selected.
- A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason or enter different letter(s).

**Step 7. If applicable, the CPT Modifiers section will be enabled.**

- Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will show.
• Choose a modifier from the Modifiers Available list and click the right pointer icon. Repeat as needed.
• To remove a modifier, choose it from the Modifiers Selected list and click the left pointer icon.
• Press and hold the <CTRL> key, and then click items to select multiple modifiers at one time.

**Step 8.** Select the providers of the services. Use the Providers Available text box to enter the following:

- Provider name (full or partial, last name first)
- Select the provider from the resulting dropdown list and click the right pointer icon.
- To remove a provider, select from the Providers Selected list and click the left pointer icon.

**Step 9.** Use the Patient Identifier field to select a patient.

- Enter one of the following:
  - Patient Name (whole or partial, last name first)
  - Social Security Number
  - Last four digits of the Patient Social Security Number
  - First character of Last Name plus the last four digits of the SSN with no spaces
- Press <Enter> on the keyboard or click the Search button.
- Choose from the list of patients displayed.

**Step 10.** Select an Eligibility Code for this procedure.

- If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure.
- The primary Eligibility Code displays as the default.

**Step 11.** Enter the Volume for the procedure.

**Step 12.** If applicable, the mandatory classification questions section will be enabled.

• Select YES only if the treatment received relates to that classification.
• Pressing the <F1> key while in the Service-Connected field will open a message dialog displaying the patient’s service connection and any rated disabilities (Figure 45).

**Figure 45: Service Connection and Rated Disabilities Dialog**
Step 13. Select the Ordering Section.
Step 14. Select an Associated Clinic for the specified DSS Unit, if applicable.
Step 15. Select the associated diagnosis code for the procedure.
   - Use the Primary field to enter one of the following:
     - ICD code (whole or partial)
     - Diagnosis Name (whole or partial)
   - Click the Search button.
   - Select from the resulting dropdown list.
   - Repeat as needed to select the Secondary Diagnosis Codes.
Step 16. Click the Add button to add this procedure for the patient.
   - The left side of the screen will remain static and will not allow edits.
   - The right side of the screen will reset to enter this same procedure for another patient.
Step 17. Repeat steps 9 through 16 to add the same procedure for another patient.
Step 18. Click the View button to verify that the list of patients entered is correct.
   - The View Patients for this Procedure screen will list all of the patients entered for the procedure that was selected (Figure 46).

Figure 46: View Patients for this Procedure Screen

Step 19. When all patients have been added for the current procedure, click OK or Cancel to return to the Data Entry menu.
Step 20. To correct an entry, return to the Data Entry menu and select Data Entry by Patient.
4.1.3 Multiple Dates / Multiple Procedures

The Multiple Dates / Multiple Procedures option allows the user to add multiple dates and multiple patients for multiple procedures.

Before the User Starts

- Event Code Screens must be defined before entering any Event Capture data.

What the User Will See

- After selecting Multiple Dates/Procs from the Data Entry Menu, the Multiple Dates/Multiple Procedures screen displays (Figure 47).
- The area at the top of the first screen provides common fields (Location, DSS Unit, and Category) as well as the Procedure Date/Time.
- Three tabs allow the user to enter providers, procedures, and patients (Providers, Procedures, and Select Patient).
- Two tabs allow the user to check the work before submitting (View Selected Patients and Records Pending Filing).

![Figure 47: Multiple Dates/Multiple Procedures Screen – Initial Screen](image)

**Figure 47: Multiple Dates/Multiple Procedures Screen – Initial Screen**
4.1.3.1 Instructions for Common Fields

Step 1. Select a Location.

- If there is only one Location set up for the Event Capture System, the Location on the screen will default to that value.
- If there is more than one Event Capture Location set up, the Location will default to the last Location used. To change the Location, choose a Location from the dropdown list of available Event Capture Locations.

Step 2. Select a DSS Unit.

- If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the user, that DSS Unit will be the default value.
- If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit from a dropdown list of accessible DSS Units.
- To gain access to an existing DSS Unit, the Event Capture Manager must assign it to the user.

Step 3. Select a Category.

- If categories are not allowed in the DSS Unit, the selection box will be disabled.
- If only one category is defined for the specified DSS Unit, that category will be the default.

Step 4. Select the Procedure Dates and Time by using the Select Date/Time dialog (Figure 48).

![Figure 48: Select Date/Time Dialog](image)

- Select date and time and click the OK button to close the dialog.
- Click the Add Date/Time button to add the choice to the Selected Dates list.
- Select and add dates as needed.
- To remove a date, choose it from the list and click the Delete Date/Time button.

**Notes:**

- The Procedure Date/Time field defaults to the current system date and time.
- To enter the current system date and time, click the Now button on the Select Date/Time dialog.
- When the Midnight button is clicked, “23:59” is displayed as the time on the date selected.

Step 5. Click and complete the tabs for Providers, Procedures and Select Patient as described in Sections 4.1.3.2, 4.1.3.3, and 4.1.3.4.
4.1.3.2 Add Information to the Providers Tab

Step 1. Click the Providers tab to select one or more providers (Figure 49).

![Figure 49: Multiple Dates/Multiple Procedures Screen, Providers Tab](image)

Step 2. Select a Provider.
- Use the Providers Available list to enter the full or partial provider name (last name first).
- Select the provider from the resulting dropdown list and click the Include button.
- To remove a provider, select from the Providers Selected list and click the Exclude button.

Step 3. Repeat as needed to add providers.
4.1.3.3 Add Information to Procedures Tab

Step 1. Click the Procedures tab to select one or more procedures (Figure 50).

Figure 50: Multiple Dates/Multiple Procedures Screen, Procedures Tab

Step 2. Select a Procedure Name.

- Select a procedure from the dropdown list.

Step 3. Enter the Volume for this procedure.

Step 4. If applicable, the Reasons field will be enabled.

- The user can enter up to three reasons.
- Reason #1 must be entered before a second or third may be entered. Reason #2 must be entered before a third may be entered.
- Reasons appear alphabetically in the dropdown.
- A reason will not appear in the dropdown list for remaining reason fields as an option once selected.
- A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason that appears is not the correct choice, click the down arrow on the reason dropdown to select another reason or enter different letter(s).
Step 5. If applicable, the Modifiers section will be enabled.

- Modifiers provide additional information about a CPT procedure. With functionality put in place by the Code Set Versioning project, only CPT modifiers that are active for the date and time of the event will display.
- Choose a Modifier from the Modifiers Available list and click the Include button.
- Repeat as needed.
- To remove a modifier, choose it from the Modifiers Selected list and click the Exclude button.
- Press and hold the <CTRL> key, and then click items to select multiple modifiers at one time.

Step 6. Click the Add Procedure button to add this procedure to the Procedures Selected list and display a blank screen ready for another entry.

Step 7. To add another procedure, repeat the steps above.

Step 8. To delete a procedure, choose it from the Selected Procedures list and click the Delete Procedure button.

Step 9. To view a procedure in an expanded format, choose it from the Selected Procedures list and click the View Details button. The View Procedure Record Details screen (Figure 51) is not editable.

Step 10. Click the Close Procedure View button to return to the Procedures tab.
4.1.3.4 Add Information to the Select Patient Tab

Step 1. Click the Select Patient tab to select one or more patients (Figure 52).

Step 2. Use the Patient Identifier field to select a patient.

- Enter one of the following:
  - Patient Name (whole or partial, last name first)
  - Social Security Number
  - Last four digits of the patient Social Security Number
  - First character of Last Name plus the last four digits of the SSN with no spaces
- Press <Enter> or click the Search button.
- Choose from the list of patients displayed.

Step 3. Select an Eligibility Code for this procedure.

- If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the Eligibility Code that applies to this procedure.
- The primary Eligibility Code displays as the default.
Step 4. If applicable, the mandatory Encounter Related classification questions section will be enabled.

- Select **YES** only if the treatment received relates to that classification.
- Pressing the <F1> key while in the Service-Connected field will open a message dialog displaying the patient’s service connection and any rated disabilities (Figure 53).

![Figure 53: Service Connection and Rated Disabilities Dialog]

Step 5. Select the Ordering Section.

Step 6. Select the Associated Clinic.

Step 7. Select the associated diagnosis code for the procedure.

- Use the Primary field to enter one of the following:
  - ICD code (whole or partial)
  - Diagnosis Name (whole or partial)
- Click the **Search** button.
- Select from the resulting dropdown list.
- Repeat as needed to select the Secondary Diagnoses Codes.

Step 8. Click the Add Patient button to add this patient to the list of Selected Patients and display a blank screen ready for another entry.

Step 9. Use the View Selected Patients tab to check the work.
4.1.3.5 Verify Information Using the View Selected Patients Tab

The following instructions are used to verify information using the View Selected Patients Tab and it can also be used to delete a patient procedure.

Step 1. Click the View Selected Patients tab to review the list of selected patients (Figure 54).

![Figure 54: Multiple Dates/Multiple Procedures View Selected Patients Tab](image)

Step 2. To remove a patient from the list, select record and click the Delete Patient button. Click the Yes button on the Confirmation message dialog (Figure 55).

![Figure 55: Deleting Patient Confirmation Dialog](image)
Step 3. To view a patient in an expanded format, select the record and click the View Details button.

- The patient record is not editable using the View Patient Record Detail screen (Figure 56).

**Figure 56: View Patient Record Details Screen**

![View Patient Record Details Screen](image)

Step 4. Click the Close Patient View button to return to the View Selected Patients tab.

### 4.1.3.6 Verify Information Using the Records Pending Filing Tab

The Records Pending Filing tab lists the individual records (transactions) that will be processed when the OK or Save button at the bottom of the screen is clicked (Figure 57).

**Step 1.** Click the Records Pending Filing tab to view a list of the records to be filed.

**Note:**

- This screen is not editable.
Step 2. Click the OK button to return to the Data Entry menu, or click Save to add more entries.

- After clicking the Save option, an information dialog will appear on the screen to show the number of records added (Figure 58).

The records consist of every combination of the dates, procedures, and patients selected on the tabs described in the preceding sections, and the providers selected will be assigned to each record.

Step 3. To change the list, review and revise the selections on the Providers, Procedure and Select Patient tabs and for the Selected Dates/Times field.

Step 4. To correct an entry, return to the Data Entry menu and select Data Entry by Patient.
4.2 Spreadsheet

Data can be batch processed in the Event Capture GUI using the spreadsheet import and upload options. Two types of spreadsheets can be used for this data entry – the regular spreadsheet or the State Home spreadsheet. Both methods of import are launched from the Spreadsheet Upload screen. Once a spreadsheet is imported into Event Capture, the data can be uploaded to VistA.

4.2.1 Import a Regular Spreadsheet

Importing is the traditional method for batch processing spreadsheet data. The spreadsheet import functionality works with MS Excel® files, as well as with tab or comma delimited files.

Before the User Starts
- A template with default column order is available to aid in populating spreadsheets prior to import. The header row will not be processed when data is imported, and it should remain in the spreadsheet during the import process.
- Any spreadsheets that do not match the column layout of the template will be rejected at import.
- The ECS spreadsheet template is available on the VA Intranet.
- Once the template is downloaded, save it to a local hard-drive for later use.
- Both *.XLS (pre-2007) and *.XLSX versions of MS Excel spreadsheets are valid for use in the Event Capture spreadsheet import process.

What the User Will See
- After selecting the Spreadsheet option from the main menu, the Spreadsheet Upload screen displays a blank grid form (Figure 59).

Figure 59: Spreadsheet Upload Screen Before Import

Steps for importing a regular spreadsheet:
Step 1. Click the Open a Regular Spreadsheet button, or select the Open Spreadsheet option from the File menu.

- A standard Select File dialog will display, allowing the user to select the spreadsheet to be imported.

Step 2. Once the desired spreadsheet is selected for import, click the Open button.

- The data is then imported into Event Capture, and will be displayed in the grid of the Spreadsheet Upload form (Figure 60).

Figure 60: Imported Spreadsheet Data Shown in the Spreadsheet Upload Form

4.2.1.1 Regular Spreadsheet Fields

The regular spreadsheet contains 37 columns. Each is described here:

**Record Num:** The Record Number is a unique number that is used to associate error messages with the correct row of data. If this field is blank, VistA validation will not be done. This is a required field.

**Location:** The Location is the station number, and it must exist in the INSTITUTION file (#4). This is a required field.

**Pat SSN:** The Patient SSN is the SSN of the patient for whom the procedure was done. It can contain only digits, and must exist in the PATIENT file (#2, ^DPT). If the SSN is shorter than 9 digits, it will be padded with leading zeros. This is a required field.

**Patient LName:** The Patient Lname (last name) field is the surname of the patient, and must contain a value at least two characters in length. Combined with the Patient FName value (in the form "last name,first name"), it must match the name in the PATIENT file (#2) for the Patient SSN associated with the row in the spreadsheet. This is a required field.

**Patient FName:** The Patient Fname (first name) field is optional. However, together with the Patient LName (in the form "last name,first name"), it must match the name in the PATIENT file (#2) for the Patient SSN associated with the row in the spreadsheet.
**DSS Unit Name:** This field indicates the DSS Unit used for the patient procedure. The DSS Unit Name is not required if the DSS Unit IEN is filled in. If this field contains a value, then it must have a “B” cross-reference on the DSS UNIT file (#724).

**DSS Department:** Because the DSS Department is not necessarily unique, it is no longer being used to identify the DSS Unit. Values entered in this field will be ignored. Use the DSS Unit Name or the DSS Unit IEN to identify the DSS Unit.

**DSS Unit IEN:** The DSS Unit IEN is an alternate way to identify the DSS Unit used for the patient procedure. It is not required if the DSS Unit Name is filled in. If the DSS Unit IEN field contains a value, that value must exist in the DSS UNIT file (#724).

**Proc Code:** The Procedure code or CPT code which represents the procedure performed for the patient. Any National Procedure, Local Procedure, or CPT code is valid for this field provided it exists in the EC NATIONAL PROCEDURE file (#725) or the CPT file (#81), and the Event Code Screen (comprised of the Location, DSS Unit, and Procedure) is active. This is a required field.

**Volume:** The Volume usually represents the number of procedures performed, but it can also be used to track the number of bed days, or the time increments spent performing the procedure. For example, if a 15-minute increment represents a unit, a Volume of 1 equals 15 minutes, a volume of 2 equals 30 minutes, etc. The volume must be a number from 1 to 99. This is a required field.

**Ordering Sect:** This is the name of the medical section which ordered the procedure for the patient. If the user enters a value for the Ordering Section, it will be validated against the “B” cross reference in the MEDICAL SPECIALTY file (#723). If the user leaves this field blank, the program will derive the Ordering Section from DSS UNIT file (#724) based on the DSS Unit IEN.

**Enc Date/Time:** This is the Date and Time of the encounter. The value can be in any valid FileMan format. The 'seconds' are ignored; the month, day, and year can be separated by any special character (non-numeric, non-alpha) except '^' and '@'. This field is required.

Examples:
- mm/dd/yy @hh:mm:ss
- mm/dd/yyyy @hh:mm:ss
- mm-dd-yy @hh:mm
- mmm dd,yyyy @hhmm
- mmddyy@hhmm
- N, N-1, N-5h, etc.

**Category:** A Category provides Event Capture a common level to group associated procedures. Multiple procedures can be defined for each category. This field is optional, and will be assigned a value of ‘0’ if blank. However, if the user enters a value, a “B” cross-reference for that value must exist in the EVENT CAPTURE CATEGORY file (#726).

**Diag Code:** This is the primary Diagnosis Code value. It must exist in the ICD DIAGNOSIS file (#80) and be active for the date/time of the encounter.

Note: The Diagnosis Code is only required for records sent to PCE, and will be ignored otherwise. For DSS Units set up as ‘OOS’, the Diagnosis Code value will be ignored.

**Assoc Clin Name:** This is the name of the Associated Clinic of the procedure. If the DSS Unit is set to send all records to PCE, either an Associated Clinic name or Associated Clinic IEN is required. If both are entered, only the IEN will be used to identify the Associated Clinic.
Assoc Clin IEN: This is the IEN of the Associated Clinic of the procedure. If the DSS Unit is set to send all records to PCE, either an Associated Clinic name or Associated Clinic IEN is required. If both are entered, only the IEN will be used to identify the Associated Clinic.

Mod 1: Modifiers provide additional information about a CPT procedure. Up to 5 unique Modifier codes can be entered for a procedure. The Mod 1 field is not required.

Mod 2: Modifiers provide additional information about a CPT procedure. Up to 5 unique Modifier codes can be entered for a procedure. The Mod 2 field is not required.

Mod 3: Modifiers provide additional information about a CPT procedure. Up to 5 unique Modifier codes can be entered for a procedure. The Mod 3 field is not required.

Mod 4: Modifiers provide additional information about a CPT procedure. Up to 5 unique Modifier codes can be entered for a procedure. The Mod 4 field is not required.

Mod 5: Modifiers provide additional information about a CPT procedure. Up to 5 unique Modifier codes can be entered for a procedure. The Mod 5 field is not required.

Agent Orange: This field represents whether the encounter was related to Agent Orange exposure (Y) or was not related to Agent Orange exposure (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.

Ion Rad: This field represents whether the encounter was related to Ionizing Radiation exposure (Y) or was not related to Ionizing Radiation exposure (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.

Service Conn: This field identifies if the encounter is related to a service connected condition and represents whether the patient has Service Connected eligibility (Y) or does not have Service Connected eligibility (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.

SW Asia: This field represents whether the encounter was related to Southwest Asia Conditions (Y) or was not related to Southwest Asia Conditions (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.

Mil Sexual Trauma: This field represents whether the encounter was related to Military Sexual Trauma (Y) or was not related to Military Sexual Trauma (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.

Head Neck Cancer: This field represents whether the encounter was related to Head and Neck Cancer (Y) or was not related to Head and Neck Cancer (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.

Combat Vet: This field represents whether the encounter was related to the patient’s Combat Veteran status (Y) or was not related to the patient’s Combat Veteran status (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.

SHAD: This field represents whether the encounter was related to Project Shipboard Hazard and Defense (SHAD) (Y) or was not related to Project SHAD (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.

Camp Lejeune: This field represents whether the encounter was related to Camp Lejeune exposure (Y) or was not related to Camp Lejeune exposure (N). When the spreadsheet is uploaded to VistA, validity checks will determine if a value is required in this field.
**Prov 1 Name or IEN:** This is the primary Provider for the patient procedure being added. The name (last name,first name) must exist in the NEW PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be entered.

The provider's IEN may be entered instead of the name.

A value is required in the Prov 1 Name or IEN field.

**Prov 2 Name or IEN:** This is the secondary Provider for the patient procedure being added. The name (last name,first name) must exist in the NEW PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be entered.

The provider's IEN may be entered instead of the name.

The Prov 2 Name or IEN field is optional.

**Prov 3 Name or IEN:** This is the tertiary Provider for the patient procedure being added. The name (last name,first name) must exist in the NEW PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be entered.

The provider's IEN may be entered instead of the name.

The Prov 3 Name or IEN field is optional.

**Prov 4 Name or IEN:** This is the fourth Provider for the patient procedure being added. The name (last name,first name) must exist in the NEW PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be entered.

The provider's IEN may be entered instead of the name.

The Prov 4 Name or IEN field is optional.

**Prov 5 Name or IEN:** This is the fifth Provider for the patient procedure being added. The name (last name,first name) must exist in the NEW PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be entered.

The provider's IEN may be entered instead of the name.

The Prov 5 Name or IEN field is optional.

**Prov 6 Name or IEN:** This is the sixth Provider for the patient procedure being added. The name (last name,first name) must exist in the NEW PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be entered.
The provider's IEN may be entered instead of the name.

The Prov 6 Name or IEN field is optional.

**Prov 7 Name or IEN:** This is the seventh Provider for the patient procedure being added. The name (last name, first name) must exist in the NEW PERSON file (#200) and have a "B" cross reference in that file. The Provider must have an active Person Class unless the DSS Unit is set to send no records to PCE; in that case, a Non-Licensed Provider (identified in the "Providers" option on the ECS Management Menu) may be entered.

The provider's IEN may be entered instead of the name.

The Prov 7 Name or IEN field is optional.

### 4.2.1.2 Edit Cell Data on the Spreadsheet Upload Form

All imported data can be modified in the Spreadsheet Upload form. The information from the selected cell is displayed in the Cell Data edit box (located above the grid). The value can be changed in either the edit box or the cell itself.

Data in each cell can be cut, copied, or pasted using the edit menu functions (Figure 61). The contents of an individual cell can be deleted using either the Cell Data edit box, or by clicking twice in the cell to highlight the data and pressing the <Delete> key.

**Note:**
- Quickly double-clicking within the cell does not select the data within the cell. To select data within a cell, click once within the cell, then click again to select the cell’s contents.

To delete an entire record, click once on a cell within the record to be deleted, then press <CTRL + Delete>. Alternatively, the user can select Edit > Delete Row from the menu bar. Rows can be inserted using the Edit > Insert Row function on the menu bar.

To delete a column within the Spreadsheet Upload form, select a cell within the column to be deleted, then use the Edit > Delete Column function. Columns can also be inserted using the Edit > Insert Column function on the menu bar.

For any accidental or undesired action performed, the user has the ability to undo that action by selecting Edit > Undo or by pressing <Ctrl + Z>. The undo function can be used multiple times to undo multiple actions.

**Figure 61: Spreadsheet Upload – Edit Functions**
Note:
- Help is available for each column in the spreadsheet. Click any column, and then click the Help button.

4.2.1.3 Modify Column Order

When the Spreadsheet Upload form is opened, the column headers are displayed in a default order. The user can change the order of the columns if the EC Template is not used.

Step 1. Click the Column Header button, or select the Change Column Headers option from the Spreadsheet Options menu.
- The Column Headers form will be displayed (Figure 62).

![Figure 62: Column Headers Form](image)

Step 2. To change the order of the columns, highlight the column heading from the list and click either the Move Up or Move Down button.
- Repeat Step 2 until the column order matches the columns order of the spreadsheet. Click the Apply button to save the column order.

Note:
- The default column header order is as follows:
  - Record Num
  - Location
  - Pat SSN
  - Pat LName
  - Pat FName
  - DSS Unit Name
  - DSS Department
  - DSS Unit Internal Entry Number (IEN)
  - Proc Code
4.2.2 Import a State Home Spreadsheet

State Home facilities use Excel spreadsheets for tracking patient occupancy. Event Capture can directly import, and upload, the data from these spreadsheets.

Before the User Starts

- The State Home spreadsheet template is available for download from the State Home website.
- Once the template is downloaded, save it to a local hard-drive for later use.
- Both *.XLS (pre- 2007) and *.XLSX versions of MS Excel spreadsheets are valid for use in the Event Capture spreadsheet import process.
- The State Home Name is located in the spreadsheet in cell B853. The name starts after the second space. All control, “^”, “;” and “:” characters are stripped from the text found in the cell. The name is then truncated to 25 characters.

What the User Will See

- From the Spreadsheet Upload screen, the user will click the State Home Spreadsheet icon or use the menu to select File > Open a State Home Spreadsheet…
- A Select File Dialog opens, prompting the user to locate and select the appropriate State Home spreadsheet (Figure 63).
Figure 63: Select File Dialog - Open a State Home Spreadsheet

![Select File Dialog](image)

**Note:**
- Multiple months of State Home data can be stored in a single spreadsheet by using tabbed worksheets to represent the various months. Only the worksheet that was active when the spreadsheet was last saved will be imported.

**Step 1.** Once the desired State Home spreadsheet is selected for import, click the **Open** button.
  - A screen prompting the user for more information, including Facility Type, Location, DSS Unit, Date and Provider(s), is displayed (Figure 64).

Figure 64: Additional Data Form for State Home Spreadsheet Import

![Additional Data Form](image)

**Notes:**
- All fields must contain data in order to import a State Home spreadsheet.
- Click the **Cancel** button on this screen to abort the import process.

**Step 2.** Click the **OK** button on this screen to continue with the import.
  - The data is then imported into Event Capture, and will be displayed in the grid of the Spreadsheet Upload form.
4.2.3 Upload Imported Spreadsheet Data

To start the upload process, click the Upload Records button on the toolbar, or select the Upload Records to VistA option from the EC Upload menu.

Before the User Starts

- Each record in the imported spreadsheet is validated before being filed in the EVENT CAPTURE PATIENT file (#721).
- Two levels of validation occur:
  1. The first level of validation occurs within the Event Capture GUI application. A check for required information is performed, and no data transmits to VistA if this level of validation fails for any record in the spreadsheet.
  2. The second level of validation occurs on the server side for each record in the spreadsheet. Records that pass this level of validation are filed in the EVENT CAPTURE PATIENT file (#721); records that fail this level of validation are not filed. Records that are filed are removed from the spreadsheet grid, leaving only those records containing errors. Each of the remaining records in the spreadsheet will have its associated error message(s) displayed in the Error Messages box. The errored record(s) can then be edited before retransmitting, or deleted.

Note:

- To highlight the cell in the grid that most likely caused the error, select an error message. This will assist in identifying, and correcting, missing or invalid data.

What the User Will See

- A progress bar will display indicating what percentage of the upload is complete.
- Any failures or errors will be reported to the user.

4.2.3.1 Spreadsheet Upload Errors

During the upload process, misspelled names, blank spaces, misaligned columns, missing data such as answers to service connected questions, duplicate records and others can lead to upload errors. These must be cleared before the record(s) will upload. When upload errors occur, a list of all errors (Service Connected errors and others) is available for export by clicking the Create Error XLS button on the Spreadsheet Upload screen (Figure 65).
The following errors may display while uploading data to VistA via the Spreadsheet option:

- **Record Number**: When transmitting records, each row in the spreadsheet needs a unique record number (i.e., 1, 2, 3, etc.). If this field is blank, VistA validation will not be done.
  - Delphi messages:
    - Error getting column with record number
    - Record number is a mandatory field
  - VistA message:
    - Location not in Institution file (#4) – Invalid Station Number

- **Location**: The location must exist in the INSTITUTION file (#4) (also known as ^DIC(4,D0,0), where D0 is the location number). During the spreadsheet upload process, Locations are identified by their STA6A identifiers.
  - VistA message:
    - Location not in Institution file (#4) – Invalid Station Number

- **Pat SSN**: The Patient SSN must exist on the PATIENT file (#2) (also known as global file ^DPT). If the SSN is shorter than 9 digits, it will be filled with leading zeroes. Do not use dashes in the SSN.
  - VistA messages:
    - No SSN x-ref on PATIENT file (#2)
    - No SSN entry on PATIENT file (#2)
    - No internal entry on PATIENT file (#2) for SSN x-ref
    - SSN does not match SSN on PATIENT file (#2)

- **Patient LName and Patient FName**: The patient’s name (last name, first name) must match the name on the PATIENT file (#2) for that SSN.
  - Delphi messages:
    - Error getting column with Patient LName
    - Patient LName must be at least 2 characters long
  - VistA messages:
    - Patient last name does not match VistA
    - Patient first name does not match VistA

- **DSS Unit Name**: If this field contains a value, then it must have a “B” cross-reference on the DSS UNIT file (#724). The DSS Unit Name is not required if the DSS Unit IEN contains a value.
  - VistA message:
    - Invalid DSS Unit Name

- **DSS Unit IEN**: If this field contains a value, then it must exist on the DSS UNIT file (#724). The DSS Unit IEN is not required if the DSS Unit Name contains a value.
  - VistA message
    - Invalid DSS Unit IEN

- **Proc Code**: This is the Procedure or the CPT code value (not the description). A National Procedure, Local Procedure or CPT code is valid for this column. Either the Procedure must exist in the EC NATIONAL PROCEDURE file (#725), or the CPT must exist in the CPT file (#81). In addition, the Event Code Screen must be active for the Location, DSS Unit IEN, and Procedure/CPT combination. With functionality put in place by the Code Set Versioning project, only CPT codes that are active for the date and time of the event are processed.
  - VistA messages
    - Procedure or “D” x-ref not on EC NATIONAL PROCEDURE file (#725)
- Procedure invalid for this Location and DSS Unit
- Unable to check for active EC Event Code Screen

- **Volume**: The volume must be a number from 1 through 99.
  - Delphi error messages
    - Error getting column with Volume number
    - Volume is a mandatory field
    - Volume has a limit of 2 digits
  - VistA messages
    - Volume must be a number from 1 to 99
    - Volume must contain numeric characters only

- **Ordering Section**: This is the name of the Ordering Section. Validation (against the “B” cross-reference in the MEDICAL SPECIALTY file (#723)) occurs for Ordering Section values used in the spreadsheet. If this field is blank, the program will derive the Ordering Section from the DSS UNIT file (#724) using the DSS Unit IEN. The record will then be transmitted to the Event Capture filer program.
  - VistA message
    - Invalid Ordering Section
    - Unable to determine Ordering Section

- **Prov Name or IEN**: This is the Provider’s last and first name as it appears in the “B” cross-reference of the NEW PERSON file (#200). If the provider also has a middle initial, then it should be included (e.g., ‘ECPROVIDER, SEVEN J’). If the system finds a partial match for the name, the application will return the provider information (provider name, IEN, specialty, subspecialty, person class), and the user can then determine which provider is correct. The Provider Name must have a “B” cross-reference in the NEW PERSON file (#200), and the person class must be active.
  - VistA messages
    - Provider has no B x-ref on NEW PERSON file (#200)
    - Unable to determine person class
    - Provider does not have an active person class

- **Enc Date/Time**: The Encounter Date/Time can be in any valid FileMan format.
  - Examples:
    - mm/dd/yy @hh:mm
    - mm/dd/yyyy @hh:mm
    - mm-dd-yy @hh:mm
    - mmddyy @hhmm
    - N, N-1, N-1H, etc.
  - VistA message
    - Invalid encounter date/time

- **Category**: The Category field can be blank. If the user enters a value, it needs to have a “B” cross-reference in the EC CATEGORY file (#726).
  - VistA message
    - Category “B” x-ref not on EC CATEGORY file (#726)
• **Diag Code**: This is the primary Diagnosis Code value. It must exist on the ICD DIAGNOSIS file (#80). With functionality put in place by the Code Set Versioning project, only ICD codes that are active for the date and time of the event process are valid. The Diagnosis Code is only required for records sent to PCE. The system ignores it otherwise.
  - VistA messages
    ♦ Diagnosis code is required for this DSS Unit
    ♦ Unable to retrieve Diagnosis IEN

• **Assoc Clinic**: This is the Associated Clinic name. It must have a “B” cross-reference on the HOSPITAL LOCATION file (#44), be of type “C” (clinic), and be active for that encounter date. The Associated Clinic must have conforming stop codes to be selectable. The Associated Clinic is only required for records sent to PCE; otherwise, it will be ignored.
  - VistA messages
    ♦ Associated Clinic is required for this DSS Unit
    ♦ Assoc Clin “B” x-ref not found on HOSPITAL LOCATION file (#44)
    ♦ Assoc Clin not found on HOSPITAL LOCATION file (#44)
    ♦ Associated Clinic must be of type "C" (clinic)
    ♦ Associated Clinic inactive for this encounter date

• **Modifier (1 through 5)**: This is the Modifier, or Modifiers, associated with the procedure.
  - VistA message
  - Modifier is invalid or duplicated for the selected procedure

### 4.2.3.2 Service Connected Questions Validation

The Service Connected (SC) classification data validation and requirements are similar to those for records entered using other ECS data entry options. In order to assist the user in gathering SC information, Event Capture generates a spreadsheet of SC-related deficiencies found when transmitting the data.

When recording patient data in ECS using the spreadsheet menu and the ECS unit is set to send “ALL Records” to Patient Care Encounters (PCE), the SC classification data must also be entered. The care being entered into ECS must be identified as being related to the SC condition with the value of “Yes” or “No”. The records that are missing the SC data will fail the upload process and will be displayed in the Error Messages area at the bottom-left of the Spreadsheet Upload from.

When a row fails validation, a Create Error XLS button will appear above the Error Messages box (Figure 65).

**Figure 65: Service Connected Error Messages and Create Error XLS Button**
Click the button to generate an Excel spreadsheet, which the user can then save, print, or email to help resolve the errors. Service Connected errors are displayed on the “SC data required” tab (Figure 66). Any other errors (non-Service Connected errors) are displayed on the “Other errors” tab (Figure 67).

![Figure 66: Export Errors – SC Data Required](image)

![Figure 67: Export Errors – Other Errors](image)

### 4.2.3.3 Duplicate Record Errors

If the system detects duplicate records when the spreadsheet uploads, a File Duplicate Record(s) checkbox appears on the screen. The duplicate records display in the Error Messages box. Checking the File Duplicate Record(s) box and retransmitting the spreadsheet files the duplicate records in the EVENT CAPTURE PATIENT file (#721).

**Notes:**
- Duplicate overrides can be disabled (or allowed) for any given DSS Unit.
- If an override is attempted for a DSS Unit where Allow Duplicate Override is set to No, the override will not succeed and will produce an error message similar to “The DSS Unit Associated with this record does not allow duplicate entries – Record NOT filed.”
- The Edit DSS Unit screen can be used by managers to allow or prevent duplicate overrides.

If the user-defined threshold of duplicate records is reached, a screen is displayed with the options to continue processing the records, change the threshold, or abort the upload (Figure 68).

![Figure 68: Duplicate Record Threshold Reached Screen](image)
• **Continue**: Resets the counter and resumes processing records.

• **Change**: Allows the user to change the duplicate record threshold.
  - This threshold can also be altered prior to starting the upload process by selecting the Change Duplicate Threshold option from the Spreadsheet Options menu or by clicking the Duplicate Threshold button.

• **Abort**: Terminates the upload process.

### 4.2.4 Upload Completion

As records are processed, the uploaded rows will be cleared from the data grid, and a progress indicator will display the number of rows uploaded and the number of records in error (Figure 69). When all rows have been uploaded, both the data grid and the Error Messages list will be clear of all records.

**Figure 69: Spreadsheet Upload Progress Indicator**

### 4.3 Reports

The following subsections describe the reports available within Event Capture.

#### 4.3.1 Reports Available to All Users

Ten reports are available to all ECS users. ECMGR security key holders have access to additional reports as described in Section 4.3.2.

**Before the User Starts**

- The following reports are available to all users (including ECMGR key holders):
  - DSS Unit Activity Report
- DSS Unit Workload Report
- ECS Records Failing Transmission to PCE Report
- Event Capture Encounters Report
- Ordering Section Summary Report
- Patient Summary Report
- PCE Data Summary Report
- Possible Late State Home Entries Report
- Procedure Reasons Report
- Provider Summary Report
- Provider (1-7) Summary Report

- Test patient data is excluded from reports (except test patient data entered for DSS Units CH103-109)

What the User Will See

- A list of reports will be available in the Select Report area (Figure 70).
- The DSS Unit Activity Report will be the default selection, and the corresponding selection criteria will display on the right side of the screen.

Figure 70: Reports Available to All Users

4.3.1.1 DSS Unit Activity Report

The DSS Unit Activity Report allows the user to print, display, or export all patients for the specified location(s) and DSS Unit(s), within a selected date range (Figure 71).

- The report can be sorted by patient, provider or SSN.
- If more than one location has been set up, choose one or all locations.

Step 1. Enter a data range.
Step 2. Select one or all Location(s).
Step 3. Select one or all DSS Unit(s).
Step 4. Choose Sort Method (Patient, Provider, or SSN) for the report.

**Notes:**
- Only the last four digits of the patient’s SSN will appear on the preview of this report.
- The column order does not change with Sort Method when exported into Excel.

Step 5. Export, Preview, Print, or Cancel the report.

The Report Preview output (Figure 72) includes Patient Name, Last four digits of Patient SSN, Inpatient/Outpatient Indicator, Procedure Date and Time, Procedure Code, Procedure Name, Volume, Primary Diagnosis, Associated Clinic Name, Stop Code, Credit Stop, CHAR4 Code, Primary Provider, and Synonym. After previewing the report, the user will have the option to print or close the report.
The Export output produces the same information for the selected criteria, in Excel format (Figure 73).

4.3.1.2 DSS Unit Workload Report

The DSS Unit Workload Report displays the number of procedures performed in each of the selected DSS Units. Refer to Figure 74 for an example of the report selection screen.

- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.

**Step 1.** Enter a date range.

**Step 2.** Select one or all location(s).

**Step 3.** Select one or all DSS Unit(s).

**Step 4.** Export, Preview, Print, or Cancel the report.
Figure 74: DSS Unit Workload Report Selection Criteria

Figure 75 shows the output for the DSS Unit Workload Preview option. If the DSS Unit uses categories, it will list the procedures in each category and how many were performed. It will also list the total number of procedures for the unit, at the bottom of the unit listing. After previewing the report, the user will have the option to print or close the report.
The Export option produces the same information for the selected criteria in Excel format (Figure 76).

4.3.1.3 ECS Records Failing Transmission to PCE Report

The ECS Records Failing Transmission to PCE Report provides a list of encounters and the reasons why records were not transmitted to PCE. Refer to Figure 77 for an example of the report selection screen.

- Locations, DSS Units, procedures, five-character EC National Codes (when applicable), and categories must be defined before using this option.

Step 1. Select the date range.

Step 2. Export, Preview, Print, or Cancel the report.
Figure 77: ECS Records Failing Transmission to PCE Report Selection Criteria

Figure 78 shows the output for the Preview option of the ECS Records Failing Transmission to PCS Report. The Procedure Date/Time, Location, DSS Unit, Patient, Procedure, Category, last four digits of the Patient's SSN, Provider(s) of care and Reasons for transmission failure are listed on the report. After previewing the report, the user has the option to print or close the report.
The Export option produces the same information for the selected criteria in Excel format (Figure 79).

4.3.1.4 Event Capture Encounters Report

This option allows you to print/display/export Event Capture encounter data within a specified date range for selected locations and DSS units. Refer to Figure 80 to view the report selection screen.

- Displays and counts the sum of occurrences by patient and DSS Unit during a selected date range. It also enables sorting by patient or by provider.
  - Sorting by Patient (Figure 82) shows the sum of occurrences for the Patient across the date range that is selected.
  - Sorting by Provider (Figure 83) shows the sum of occurrences for the Provider across the date range that is selected.
- Includes the fields Patient Name, SSN (last 4 digits), Inpatient or Outpatient (I/O), Date/Time, Provider #1, DSS Unit and Volume.

**Step 1.** Select a date range.

**Step 2.** Select one or all Locations.

**Step 3.** Select one, all, or multiple DSS Unit(s).
Step 4. Select Sort Method (Patient or Provider).
Step 5. Export, Preview, Print, or Cancel the report.

Notes:
- Only the last four digits of the patient’s SSN will appear on the preview of this report.
- The column order does not change with Sort Method when exported into Excel.
- A report timeout warning and message dialog are displayed when All Locations, All DSS units, or large date ranges are selected (Figure 81)

Figure 80: Event Capture Encounters Report Selection Criteria

Figure 81: Event Capture Encounters Report Timeout Warning
The preview output includes the Patient Name, SSN (last 4 digits), Inpatient or Outpatient (I/O), Date/Time, Provider #1, DSS Unit, Volume, Clinic, Stop Code, Credit Stop Code, CHAR4 Code and MCA Labor Code. After previewing the report, the user will have the option to print or close the report.

The Export option produces the same information for the selected criteria in Excel format (Figure 84).
4.3.1.5 Ordering Section Summary Report

The Ordering Section Summary Report allows the user to print/display procedures ordered within a specified date range for a selected ordering section. Refer to Figure 85 for an example of the report selection screen.

- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
- After previewing the report, the user will have the option to print or close the report.

Step 1. Enter a date range.
Step 2. Select an Ordering Section.
Step 3. Select a specific or all Location(s).
Step 4. Select one, multiple, or all DSS Unit(s).
Step 5. Export, Preview, Print, or Cancel the report.
Figure 86 is an image of the Ordering Section Summary Report from Preview.

**Figure 86: Report Preview - Ordering Section Summary Report**

The Export option produces the information for the selected criteria in Excel format (Figure 87).

**Figure 87: Export - Ordering Section Summary Report**

### 4.3.1.6 Patient Summary Report

The Patient Summary Report allows the user to print/display procedure-related data within a specified date range for a selected patient. Refer to Figure 88 to view the report selection screen.

- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.
- The user can choose to include Procedure Reasons (EVENT CAPTURE PATIENT file (#721)) on the report. Up to three reasons will be included.
- The “Display Reasons on this report” option will clear when the user selects another report or upon exiting the screen.
- After previewing the report, the user will have the option to print or close the report.

**Step 1.** Enter a date range.

**Step 2.** Use the Patient Identifier field to select a patient.

- Enter one of the following:
- Patient Name (whole or partial, last name first)
- Social Security Number
- Last four digits of the Patient Social Security Number
- First character of Last Name plus the last four digits of the SSN with no spaces

- Press <Enter> on the keyboard or click the Search button.
- Choose from the list of patients displayed.

**Step 3.** Click the Display Reasons on this report checkbox to include Procedure Reasons in the report (Figure 91).

**Step 4.** Export, Preview, Print, or Cancel the report.

---

**Figure 88: Patient Summary Report (without Reasons) Selection Criteria**

![Patient Summary Report Screenshot](image-url)
Figure 89: Report Preview - Patient Summary Report (without Reasons)

The Export option produces the information for the selected criteria in Excel format (Figure 90).

Figure 90: Export - Patient Summary Report (without Reasons)
Figure 91: Patient Summary Report (with Reasons) Selection Criteria

Figure 92: Report Preview - Patient Summary Report (with Reasons)
The Export option produces the information for the selected criteria in Excel format (Figure 93).

![Figure 93: Export - Patient Summary Report (with Reasons)](image)

### 4.3.1.7 PCE Data Summary Report

The PCE Data Summary Report allows the user to print/display procedure data that was sent to the PCE software for a selected patient within a specified date range. Refer to Figure 94 to view the report selection screen.

- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated descriptions are reflective of the date the event occurred.

**Step 1.** Enter a date range.

**Step 2.** Use the Patient Identifier field to select a patient.

- Enter one of the following:
  - Patient Name (whole or partial, last name first)
  - Social Security Number
  - Last four digits of the Patient Social Security Number
  - First character of Last Name plus the last four digits of the SSN with no spaces

- Press <Enter> on the keyboard or click the **Search** button.

- Choose from the list of patients displayed.

**Step 3.** Export, Preview, Print, or Cancel the report.
The Preview option output includes Patient Name, Date Range, Date/Time of procedure, Procedure Name (as sent to PCE), Volume, Provider, Location, Associated Clinic, Stop Code, Credit Stop Code, CHAR4 Code, MCA Labor Code, CPT Code, ICD-10 code and Modifier(s) (Figure 95). After previewing the report, the user has the option to print or close the report.
The Export option produces the information for the selected criteria in Excel format (Figure 96).

4.3.1.8 Possible Late State Home Entries Report

The Possible Late State Home Entries Report lists all possible late State Home entries for the selected date range. These are State Home records that were entered for prior months that could be included in a previously completed ECS Extract. Refer to Figure 97 for an example of the report selection screen.

Note:
- Late State Home entry reporting is limited to the current fiscal year. Late State Home records for previous fiscal years are not processed, nor will they be included on this report.

Step 1. Select a date range.
Step 2. Export, Preview, Print, or Cancel the report.
The preview output includes the DSS Unit, Location, Patient Name, last 4 digits of SSN (full on export), Procedure Date/Time, Entered Date/Time, Entered By (export only), Procedure, Volume and Primary Provider. After previewing the report, the user will have the option to print or close the report.

The Export option produces the information for the selected criteria in Excel format (Figure 99).
4.3.1.9 Procedure Reasons Report

The Procedures Reasons Report lists the reasons entered for Event Capture Procedures. Refer to Figure 97 for an example of the report selection screen.

**Notes:**
- Locations, DSS Units, procedures, and procedure reasons must be defined before using this option.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated descriptions are reflective of the date the event occurred.

**Step 1.** Select a date range.

**Step 2.** Select one, all, or multiple Location(s).

**Step 3.** Select one, all, or multiple Procedure Reasons.

**Step 4.** Select one, all, or multiple DSS Unit(s).

**Step 5.** Export, Preview, Print, or Cancel the report.
The report preview output includes the Location, DSS Unit, Procedure Reason, the number of times the reason was used, Procedure Code, Procedure Name, Patient Name, last four digits of Patient SSN, Provider Name, and Date and Time of the procedure (Figure 101). After previewing the report, the user has the option to print or close the report.
This report is exportable into an Excel spreadsheet. The tab in Excel is titled “Reasons” followed by the Date Range the user selected (Figure 102).

![Figure 102: Export - Procedure Reasons Report](image)

### 4.3.1.10 Provider Summary Report

The Provider Summary Report allows the user to print, preview, or export the number of procedures performed for one or all locations and one or all DSS Units within a specified date range. Within each DSS Unit for each location, the report is sorted by provider, category (if the DSS Unit is defined to sort procedures by category), and procedures (listed alphabetically) Refer to Figure 103 for an example of the report selection screen.

**Notes:**
- Locations, DSS Units, categories, procedures and procedure reasons must be defined before generating this report.
- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.

**Step 1.** Enter a date range.

**Step 2.** Select one or all Location(s).

**Step 3.** Select one or all DSS Unit(s).

**Step 4.** Export, Preview, Print, or Cancel the report.
The preview option output includes Location, DSS Unit, Provider, Category (if applicable), CPT Code, Procedure Code, Procedure Name, Procedure Reason, Volume, Modifier(s), and Total number of procedures performed by the provider within the specified date range (Figure 104).

**Note:**
- If Procedure Reason #1 is not listed, the report prints “Reason Not Defined”.
The Export option produces the information for the selected criteria in Excel format (Figure 105).

4.3.1.11 Provider (1-7) Summary Report

The Provider (1-7) Summary Report summarizes the workload of providers for a selected date showing how many times a specific procedure was performed on a patient with the selected provider. This report provides the ability to view up to seven provider numbers for providers within a Location/DSS Unit. Refer to Figure 106 to view the report selection screen.

Notes:
- The design of this report is for a 132-column format.
- With functionality put in place by the Code Set Versioning project, CPT codes, five-character EC National Codes (when applicable), CPT modifiers and their associated descriptions are reflective of the date the event occurred.

Step 1. Enter a date range.
Step 2. Enter the name of a Provider.
Step 3. Select one, all or multiple Location(s).
Step 4. Select one, all, or multiple DSS Unit(s).
Step 5. Export, Preview, Print, or Cancel the report.
The Preview option output includes Procedure Code, Procedure Name, Patient Name, Last four digits of patient SSN, a matrix showing how many times a specific procedure was performed on a specific patient with the selected provider as Provider 1, Provider 2, to Provider 7, Modifier(s), Subtotals by procedure, and Grand Total of procedures (Figure 107). After previewing the report, the user has the option to print or close the report.
The Export option produces the information for the selected criteria in Excel format (Figure 108).

![Figure 108: Export - Provider (1-7) Summary Report](image)

### 4.3.2 Reports Available to ECMGR Key Holders Only

The following reports are available only to ECMGR key holders:

- Category Report
- Disabled Category and Procedure Summary
- DSS Units with any Associated Stop Code Errors
- DSS Units/Event Code (EC) Screens for Selected Procedure Code Report
- DSS Unit Users Access Report
- Event Code Screens with CPT Codes Report
- Event Code Screens with Inactive Default Associated Clinic
- Inactive Person Class Report (IPC)
- National / Local Procedure Codes with Inactive CPT Codes
- National / Local Procedure Report
- Print Category and Procedure Summary (Report)
- Send No Records DSS Units Report

ECMGR reports are displayed in the Select Report area, below the asterisk line (Figure 109).

![Figure 109: Report Selection Screen for ECMGR Key Holders](image)
4.3.2.1 Category Report

The Category Report allows Management users to print, preview, or export the established local categories. This report can be generated for active categories, inactive categories, or all categories. For inactive categories, the inactive date is included in the output. Refer to Figure 110 for an example of the report selection screen.

**Note:**
- Use the Category - Add or Update Categories option to create categories before selecting this report.

**Step 1.** Select the report.

**Step 2.** Choose a status of Active, Inactive, or Both.

**Step 3.** Export, Preview, Print, or Cancel the report.

![Figure 110: Category Report Selection Criteria](image)

Selecting Active and then Preview produces output showing the list of active categories (Figure 111). After previewing the report, the user has the option to print or close the report.
The Export option produces the information for the selected criteria in Excel format (Figure 112).

Figure 112: Export - Category Report (Active)

Selecting Inactive and then Preview produces output showing the list of inactive categories (Figure 113).

Figure 113: Report Preview - Category Report (Inactive)
The Export option produces the information for the selected criteria in Excel format (Figure 114).

![Figure 114: Export - Category Report (Inactive)](image)

Selecting Both, and then Preview produces output showing the list of both active and inactive categories (Figure 115).

![Figure 115: Report Preview - Category Report (Both Active and Inactive)](image)

The Export option produces the information for the selected criteria in Excel format (Figure 116).

![Figure 116: Export - Category Report (Both Active and Inactive)](image)

**4.3.2.2 Disabled Category and Procedure Summary**

This report allows Management users to print, preview, or export the ECS categories that have been disabled for one or all DSS Units within a specified location. Event Code Screens that are comprised of DSS Units that allow category use, and have Event Code Screens defined using the disabled category will appear on this report. Refer to Figure 117 for an example of the report selection screen.
Step 1. Select the report.
Step 2. Select one, all, or multiple Location(s).
Step 3. Export, Preview, Print, or Cancel the report.

Figure 117: Disabled Category and Procedure Summary Report Selection Criteria

The report preview output includes the Run Date, Location, Service, DSS Unit Name and IEN, Send Status, and DSS Dept. For each disabled procedure, the report also includes Procedure Code, Procedure Name, Synonym, Clinic IEN, Clinic, Stop Code, Credit Stop Code, CHAR4 Code and MCA Labor Code (Figure 118). After previewing the report, the user has the option to print or close the report.
The Export option produces the information for the selected criteria in Excel format (Figure 119). The exported output includes EC Screen Status, Location, Service, DSS Unit, DSS Unit IEN, DSS Dept., Send Status, DSS Unit Inactive, Disabled Category, CPT Code, Procedure Code, Procedure Name, Synonym, Clinic IEN, Clinic, Clinic Stop Code, Credit Stop Code, CHAR4 Code and MCA Labor Code.

4.3.2.3 DSS Units with Any Associated Stop Code Errors Report

The Event Capture software restricts DSS-only workload to using valid Stop Codes. This report provides Management users a list of DSS Units with any error with the Associated Stop Code. Refer to Figure 120 for an example of the report selection screen.
Notes:

- To assist sites in locating DSS Units that have invalid associated Stop Codes, the DSS Unit list with Secondary Associated Stop Codes is provided. This may be attached as a secondary menu option and run as often as needed. The only prompt is for Device.
- Select an active, non-secondary Stop Code to replace the Stop Code in the DSS Unit setup.

Step 1. Select the report.

Step 2. Export, Preview, Print, or Cancel the report.

Figure 120: DSS Units with Any Associated Stop Code Errors Selection Criteria

The report preview produces output that includes the DSS Unit IEN and name, Associated Stop Code IEN, and name and the reason for the error (Figure 121). After previewing the report, the user has the option to print or close the report.
The Export option produces the information in Excel format (Figure 122).

### Figure 122: Export - DSS Units with Any Associated Stop Code Errors

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>46</td>
<td>111 OOS TEST</td>
<td>110</td>
<td>1100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INTERV RAD PRE/POST CNSLT</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**DSS Units with Stop Code Errors**

### 4.3.2.4 DSS Units/Event Code (EC) Screens for Selected Procedure Code Report

The DSS Units/Event Code Screen for Selected Procedure Code Report allows Management users to print, preview, or export DSS unit and EC screen data for a selected procedure code and specified locations. Refer to Figure 123 for an example of the report selection screen.

**Note:**
- The design of this report is for a 132-column format.

**Step 1.** Select the report.

**Step 2.** Select one, all, or multiple Location(s).

**Step 3.** Select a Procedure.

**Step 4.** Export, Preview, Print, or Cancel the report.
Figure 123: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report Selection Criteria

![DSS Units/Event Code (EC) Screens for Selected Procedure Code Report Selection Criteria]

Figure 124: Report Preview - DSS Units/Event Code (EC) Screens for Selected Procedure Code Report


This report is exportable into an Excel spreadsheet (Figure 125). The tab in Excel is titled “Selected Procedure Code”.
4.3.2.5 DSS Unit User Access Report

The DSS Unit User Access Report allows Management users to print, preview, or export information regarding user with access to DSS unit data for specified locations and DSS units. Refer to Figure 126 for an example of the report selection screen.

**Note:**
- Similar information is available using the Management Menu > Access by User option (Refer to Section 4.4.3).

**Step 1.** Select the report.

**Step 2.** Select one or all Location(s).

**Step 3.** Select one, all, or multiple DSS Units.

**Step 4.** Export, Preview, Print, or Cancel the report.
The report preview produces output that includes DSS Unit Name, User Name, User IEN (from the New Person (#200) file), and Person Class/Classification (Figure 127). After previewing the report, the user has the option to print or close the report.

**Figure 127: Report Preview - DSS Unit User Access Report**

This report is exportable into an Excel spreadsheet (Figure 128). The tab in Excel is titled “DSS Unit User Access Report” and includes the information for the selected criteria.

**Figure 128: Export - DSS Unit User Access Report**

### 4.3.2.6 Event Code Screens with CPT Codes Report

This option allows Management users to print, preview, or export Event Code Screens with active and/or inactive CPT codes for one or all specific DSS Unit(s). Refer to Figure 129 for an example of the report selection screen.

---

**Step 1.** Select the report.

**Step 2.** Select One or all Location(s).

**Step 3.** Select one or all DSS Unit(s).
Note:
- If “All” is selected for the DSS Unit, the Category will also be set to “All” and will be disabled.

Step 4. Select a Category.

Note:
- Categories only appear if the Event Code Screen uses categories to group procedures.

Step 5. Select Active, Inactive, or Both (Active and Inactive) CPT Codes.

Step 6. Export, Preview, Print, or Cancel the report.

Figure 129: Event Code Screens with CPT Codes Report Selection Criteria

The report preview output includes Run Date and Time, Location, DSS Unit, Category, Procedure Name, National Number, CPT Code, Synonym, Associated Clinic, Stop Code, Credit Stop, CHAR4 Code and MCA Labor Code (Figure 130). After previewing the report, the user has the option to print or close the report.

Notes:
- Inactive CPT codes are flagged with an *I* when printing both active and inactive codes.
- Category, Synonym, Associated Clinic and MCA Labor Code are included only when data is available for those items.
This report is exportable into an Excel spreadsheet. The tab of the exported report indicates whether the report shows only active, only inactive, or both active and inactive CPT codes (Figure 131). When exporting the report, all Inactive CPT codes are flagged with an **Inactive** indicator.

4.3.2.7 Event Code Screens with Inactive Default Associated Clinic Report

The Event Code Screens with Inactive Default Associated Clinic Report allows Management users to print, preview, or export inactive default associated clinic data for specified locations and DSS units. Refer to Figure 132 for an example of the report selection screen.

**Step 1.** Select the report.

**Step 2.** Select one, all, or multiple Location(s).

**Step 3.** Select one, all, or multiple DSS Unit(s).

**Step 4.** Export, Preview, Print, or Cancel the report.
The report preview output includes DSS Unit Name, Location, Category, Procedure Code, Clinic IEN, and Clinic Name (Figure 133). After previewing the report, the user has the option to print or close the report.

The Export option produces the information for the selected criteria in Excel format (Figure 134).
4.3.2.8 Inactive Person Class Report (IPC)

The Inactive Person Class Report (IPC) allows Management users to identify providers who do not have an assigned person class or an active person class in the NEW PERSON file (#200) for the date of the procedure. Refer to Figure 135 for an example of the report selection screen.

Step 1. Select the report.

Step 2. Enter a date range.


Note:
- The column order does not change with Sort Order when exported into Excel.

Step 4. Export, Preview, Print, or Cancel the report.

The report preview output displays the Patient Name, SSN (last four), Date of Procedure, Provider and any Errors (Figure 136). After previewing the report, the user has the option to print or close the report.
The Export option produces the information for the selected criteria in Excel format (Figure 137).

4.3.2.9 National/Local Procedure Codes with Inactive CPT Codes Report

This report allows Management users to see a list of National and Local Procedure Codes with inactive CPT codes from the EC NATIONAL PROCEDURE file (#725). Refer to Figure 138 for an example of the report selection screen.

**Step 1.** Select the report.

**Step 2.** Export, Preview, Print, or Cancel the report.
The report preview displays the National Number, National Name, CPT Code, and the Inactive Date (Figure 139). After previewing the report, the user has the option to print or close the report.

**Figure 139: Report Preview - National/Local Procedure Codes with Inactive CPT Codes Report**
The Export option produces the information for the selected criteria in Excel format (Figure 140).

**Figure 140: Export - National/Local Procedure Codes with Inactive CPT Codes Report**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NATIONAL NUMBER</td>
<td>NATIONAL NAME</td>
<td>CPT CODE</td>
</tr>
<tr>
<td>2</td>
<td>SW015</td>
<td>PSYCHSOC TX/PSYCHOTHERAPY OPT 75-80 MIN</td>
<td>90808</td>
</tr>
<tr>
<td>3</td>
<td>SW055</td>
<td>PHONE-D/C NON-MENTAL HEALTHFOLLOW-UP, 45 MIN</td>
<td>99373</td>
</tr>
<tr>
<td>4</td>
<td>SP005</td>
<td>SENSORY AIDS ASSESSMENT, 15 MIN</td>
<td>92506</td>
</tr>
<tr>
<td>5</td>
<td>SP102</td>
<td>AURAL REHAB STATUS EXAM, 15 MIN</td>
<td>92506</td>
</tr>
<tr>
<td>6</td>
<td>SP009</td>
<td>COCHLEAR IMPLANT EVALUATION</td>
<td>92506</td>
</tr>
</tbody>
</table>

4.3.2.10 National/Local Procedure Report – Active Procedures

The National/Local Procedures Report allows Management users to display a listing of Event Capture active or inactive procedures (See Section 4.3.2.11 for an overview of the report for Inactive Procedures). Refer to Figure 141 to view the report selection screen.

**Note:**
- Use the Procedure - Add or Update Local Procedures option to create local procedures before using this option.

**Step 1.** Select the report.
**Step 2.** Choose Active.
**Step 3.** Choose a Preferred Report (National, Local, or Both).
**Step 4.** Choose the Sort Method (Procedure or National Code).
**Step 5.** Export, Preview, Print, or Cancel the report.
Figure 141: National/Local Procedure Report (Active) Selection Criteria

For active procedures, the report preview output includes Procedure Name, National Number, and CPT (Figure 142).

Figure 142: Report Preview - National/Local Procedure Report (Active)
The Export option produces the information for the selected criteria in Excel format (Figure 143).

**Figure 143: Export - National/Local Procedure Report (Active)**

<table>
<thead>
<tr>
<th></th>
<th>NAME</th>
<th>NATIONAL NUMBER</th>
<th>CPT</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FLU03</td>
<td>FLU03</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>INFORMATION UPDATE</td>
<td>IU999</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>JML BIOPSY</td>
<td>JML12</td>
<td>88305</td>
</tr>
<tr>
<td>4</td>
<td>JML BIOPSY 2</td>
<td>JML22</td>
<td>88304</td>
</tr>
<tr>
<td>5</td>
<td>JML BIOPSY 3</td>
<td>JML32</td>
<td>88304</td>
</tr>
<tr>
<td>6</td>
<td>M-1234</td>
<td>J5678</td>
<td>S9449</td>
</tr>
<tr>
<td>7</td>
<td>MLD LOCAL PROC2</td>
<td>A9999</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>MLD LOCAL PROCEDURE</td>
<td>A1234</td>
<td></td>
</tr>
</tbody>
</table>

4.3.2.11 National/Local Procedure Report – Inactive Procedures

The National/Local Procedures Report allows Management users to display a listing of Event Capture active or inactive procedures (See Section 4.3.2.10 for an overview of the report for Active Procedures). Refer to Figure 144 to view the report selection screen.

**Note:**
- Use the Procedure - Add or Update Local Procedures option to create local procedures before using this option.

**Step 1.** Select the report.

**Step 2.** Click the Inactive button.

**Note:**
- Selecting the Inactive radio button disables the Preferred Report and Sort Method options.

**Step 3.** Export, Preview, Print, or Cancel the report.
For inactive procedures, the report preview output includes Procedure Name, National Number, CPT, and the Inactive Date (Figure 145). After previewing the report, the user has the option to print or close the report.
The Export option produces the information for the selected criteria in Excel format (Figure 146).

![Figure 146: Export - National/Local Procedure Report (Inactive)](image)

### 4.3.2.12 Print Category and Procedure Summary (Report)

The Print Category and Procedure Summary Report allows Management users to print, display, and export the Event Code Screens for one or all DSS Units within a specified location. Locations, DSS Units, local categories, and procedures must be defined before using this option. Refer to Figure 147 for an example of the report selection screen.

**Notes:**
- Use the DSS Unit - Add or Update DSS Units option to create DSS Units categories before using this option.
- Use the Category - Add or Update Categories option to create categories before using this option.
- Use the Procedure - Add or Update Local Procedures option to create procedures before using this option.

**Step 1.** Select one or all Location(s).

**Step 2.** Select Active, Inactive or Both (Active and Inactive) DSS Units.

**Step 3.** Select one, all, or multiple DSS Unit(s).

**Step 4.** Select Active, Inactive or Both (Active and Inactive) Event Code Screens.

**Step 5.** Export, Preview, Print or Cancel the report
The report preview output includes Run Date, Location, Service, DSS Unit, Send Status, DSS Dept., Category (if applicable), Procedure Code, Procedure Name, Synonym, Associated Clinic IEN (if applicable), Associated Clinic (if applicable), Stop Code, Credit Stop Code, CHAR4 Code and MCA Labor Code (Figure 148). After previewing the report, the user has the option to print or close the report.
Figure 148: Report Preview - Print Category and Procedure Summary (Report)

The Export option produces the information for the selected criteria in Excel format (Figure 149).

Figure 149: Export - Print Category and Procedure Summary (Report)

4.3.2.13 Send No Records DSS Units Report

The Send No Records DSS Units Report provides Management users with a list of active DSS Units with send to PCE status of Send NO RECORDS. Refer to Figure 150 to view the report selection screen.

Step 1. Select the report.
Step 2. Export, Preview, Print, or Cancel the report.
The report preview output includes DSS Unit Name and IEN, Associated Stop Code [and Credit Stop and CHAR4 Code if present (Figure 151)]. After previewing the report, the user has the option to print or close the report.
The Export option produces the information for the selected criteria in Excel format (Figure 152).

**Figure 152: Export - Send No Records DSS Units Report**

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DSS UNIT IEN</td>
<td>DSS UNIT NAME</td>
<td>STOP CODE</td>
<td>CREDIT STOP</td>
</tr>
<tr>
<td>2</td>
<td>15</td>
<td>CRUDS-S</td>
<td>106</td>
<td>418</td>
</tr>
<tr>
<td>3</td>
<td>33</td>
<td>DAVE TEST UNIT #5</td>
<td>524</td>
<td>524</td>
</tr>
<tr>
<td>4</td>
<td>24</td>
<td>DONNA</td>
<td>525</td>
<td>524</td>
</tr>
<tr>
<td>5</td>
<td>44</td>
<td>EC TEST 2017</td>
<td>407</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>50</td>
<td>FORMER OOS CHANGE TEST</td>
<td>524</td>
<td>302</td>
</tr>
</tbody>
</table>

4.4 Management Menu

The Management Menu is available to users with the ECMGR security key. This option accesses the menus needed for management of the Event Capture software. The main menu in the Management Menu provides the following management functions (Figure 153):

- Location – Update Location Information
- DSS Unit – Add or Update DSS Units
- Access by User – Grant Access to DSS Units by User
- Category – Add or Update Categories
- Procedure – Add or Update Local Procedures
- Reason – Add or Update Procedure Reasons
- Event Code Screen – Add or Update Event Code Screens
- Inactivate EC Screen – Identify/Inactivate Multiple Event Code Screens
- Providers – Maintain Non-Licensed Providers
4.4.1 Location – Update Location Information

The Location option allows Management users to create or remove access to an Event Capture location and flag it as active or inactive for use in the Event Capture software. When creating a location, the selection can be an individual facility or a division if the facility is multidivisional.

Before the User Starts

- Location selected must be in the INSTITUTION file (#4)
- Locations must be created with this option before the user can establish DSS Units. No further options are functional until the user creates an Event Capture location.

What the User Will See

- A list of existing locations displays in a grid format (Figure 154).
- For each location listed, the following information is displayed (if available): Name, State, Facility Type, Station Number, IEN, and whether or not this location is current.
  - The Name column contains the Location Name.
  - The Station Number corresponds to the first part (the characters before the dash) of the feeder location when there is no division suffix.
  - The IEN column contains the IEN of the INSTITUTION file (#4). The IEN corresponds to the first part (the characters before the dash) of the feeder location when there is a division suffix.
- A search field is available at the top of the screen, allowing the user to search for a specific location.
Figure 154: Management Menu [Locations] Screen

From the Locations screen, the user can select a location by double-clicking on a row or by highlighting a row and then clicking the Update button. After selecting a location, an edit screen appears, allowing the user to either create the location as a current Event Capture location or to remove the selected location (Figure 155).

Figure 155: Edit Location Screen

The rows within the Locations screen can be sorted by using the Sort menu (Figure 156) or by clicking on the column header. The default sort order will group locations based on whether they are current and lists the current locations group first. In addition, the default sort order lists locations alphabetically within those groups.
To create a current location, click the checkbox labeled “Create as current Event Capture location” and click the **OK** button (Figure 157). The location is “flagged” as active for use in the Event Capture software.

**Figure 157: Creating a Current Location**

To remove a current location, click the checkbox labeled “Remove as current Event Capture location” and click the **OK** button (Figure 158). The location is “flagged” as inactive for use in the Event Capture software.

**Figure 158: Removing a Current Location**

Click the **Export** button to export the Locations listing to Excel. The tab in Excel is titled “ECS Location Table Export” (Figure 159).
4.4.2 DSS Unit – Add or Update DSS Units

The Add/Update DSS Units option allows Management users to enter and edit (but not delete) DSS Units for use with Event Capture. DSS Units typically represent the smallest identifiable work unit in a clinical service at the medical center and are defined by the VA Medical Centers (VAMCs).

A DSS Unit can represent any of the following:
- An entire service
- A section of a service
- A small section within a section
- A medical equipment item used in patient procedures

Before the User Starts
- Use the Location - Update Location Information option to create an Event Capture location before using this option.
- A prompt displays a notification to enter an Associated Stop Code only if the send “All Records” flag is set to NO.
- No further options are functional until DSS Units are created.

What the User Will See
- A list of DSS Units displays in grid format (Figure 160).
- A search field is available at the top of the screen, allowing the user to search for a specific DSS Unit. Options to search by “Active” or “Inactive” status are also available. Type in a partial search string, then click Find, and the screen filters to show entries containing the search criteria.
- The screen contains the following columns:
  - DSS Unit Name
  - Unit IEN (becomes the end of the feeder location) – corresponds to the locally created Event Capture DSS Unit Name
  - Active Status for DSS Unit (Yes or No)
  - The PCE column reflects if workload is set to pass to PCE. Values include:
    - All – Send all records
    - OOS – Send Occasion Of Service records
    - No – Send no records
  - DSS Department
• Service
• Medical Specialty
• Cost Center

Figure 160: Management Menu [DSS Units] Screen

The Print button enables users to print the report.
The Export button enables users to export the data to an Excel spreadsheet (Figure 161).

Figure 161: Export – DSS Units Table

Click the **Update** button to update an existing DSS Unit, or click the **Add** button to add a new one. The Edit a DSS Unit or Add a DSS Unit screen will appear.

Table 2 lists the element name and description for each field that appears on the Add or Edit DSS Unit screen:
### Table 2: Element Name and Description

<table>
<thead>
<tr>
<th>Element Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSS Unit Name</td>
<td>The name of the DSS Unit being created</td>
</tr>
<tr>
<td>DSS Dept. and DSS Unit IEN</td>
<td>The value used to identify the DSS Department to which the DSS Unit is associated (1 to 14 characters).</td>
</tr>
<tr>
<td></td>
<td>• The same DSS Department can be used for more than one DSS Unit</td>
</tr>
<tr>
<td></td>
<td>• The DSS Unit IEN is a unique number assigned by the server, and is not editable in this screen</td>
</tr>
<tr>
<td>Service</td>
<td>The service associated with this DSS Unit - from the SERVICE/SECTION file (#49)</td>
</tr>
<tr>
<td>Medical Specialty</td>
<td>The medical specialty associated with this DSS Unit - from the MEDICAL SPECIALTY file (#723)</td>
</tr>
<tr>
<td>Cost Center</td>
<td>The cost center associated with this DSS Unit - from the COST CENTER file (#420.1). Cost centers are defined in MP4-Part V, Appendix B of the Fiscal Service cost manuals.</td>
</tr>
<tr>
<td>DSS Unit Status</td>
<td>Active - Lists Active Event Code Screens</td>
</tr>
<tr>
<td></td>
<td>Inactive - Lists Inactive Event Code Screens</td>
</tr>
<tr>
<td>Event Code Screens</td>
<td>Retain - When an active DSS Unit is changed to inactive, its Event Code Screens can either be retained or inactivated.</td>
</tr>
<tr>
<td></td>
<td>Inactivate - When an active DSS Unit is changed to inactive, its Event Code Screens can either be retained or inactivated.</td>
</tr>
<tr>
<td></td>
<td>Reactivate - When an inactive DSS Unit is changed to active, its Event Code Screens can either be reactivated or remain inactive.</td>
</tr>
<tr>
<td></td>
<td>Remain Inactive - When an inactive DSS Unit is changed to active, its Event Code Screens can either be reactivated or remain inactive.</td>
</tr>
<tr>
<td>Default Date / Time</td>
<td>Now – The current date and time will populate during data entry</td>
</tr>
<tr>
<td></td>
<td>None – No default date and time will be populated during data entry. The user is required to enter the date and time of the patient procedure.</td>
</tr>
<tr>
<td>Allow Category Use</td>
<td>Yes – Use categories to group procedures during data entry</td>
</tr>
<tr>
<td>Allow Duplicate Override</td>
<td>No – Do not use categories to group procedures during data entry</td>
</tr>
<tr>
<td></td>
<td>Yes – Spreadsheet data for this DSS Unit can have duplicates overridden and uploaded</td>
</tr>
<tr>
<td>Send to PCE</td>
<td>No – Spreadsheet data for this DSS Unit will not allow duplicates to be overridden and uploaded</td>
</tr>
<tr>
<td>Send to PCE</td>
<td>Defines the method used to send the user's data to PCE for the DSS Unit being created.</td>
</tr>
<tr>
<td></td>
<td>All Records - Send All Records</td>
</tr>
<tr>
<td></td>
<td>No Records - Send No Records</td>
</tr>
<tr>
<td></td>
<td>Occasion Of Service – For Occasion Of Service workload that is sent to PCE</td>
</tr>
<tr>
<td>Associated Stop Code</td>
<td>Select the Stop Code associated with this DSS Unit. Be sure to select an active Stop Code.</td>
</tr>
<tr>
<td>Credit Stop Code</td>
<td>Select the Credit Stop Code associated with this DSS Unit</td>
</tr>
<tr>
<td>CHAR4 Code</td>
<td>Select the CHAR4 Code associated with this DSS Unit</td>
</tr>
</tbody>
</table>
### Notes:
- On both Add DSS Unit and Edit DSS Unit screens, the DSS Unit Status defaults to Active, and the Allow Category Use field defaults to No, but the user can select Yes.
- The default value for Allow Duplicate Override is No.
- When the Send to PCE option is set to No Records or Occasion Of Service, the Associated Stop Code field is enabled.
- When the Send to PCE option is set to All Records, the Associated Stop Code field will not be visible. All other default options can be changed.
- The user can search for the Associated Stop Code by either description or code. The Associated Stop Code will display and will include both the description and the code.

### 4.4.2.1 To Add a DSS Unit

The Add a DSS Unit function allows the user to create a new DSS Unit for within ECS.

**Step 1.** Click the Add button.
- The Add a DSS Unit Screen will display (Figure 162).

**Step 2.** Enter a DSS Unit Name.

**Step 3.** Enter a DSS Dept.

**Step 4.** Select a Service from the list provided.

**Step 5.** Select a Medical Specialty from the list provided.

**Step 6.** Select a Cost Center from the list provided.

**Step 7.** Select the DSS Unit Status.

**Step 8.** Choose the Default Date / Time.

**Step 9.** Choose whether or not to Allow Category Use.

**Step 10.** Choose whether or not to Allow Duplicate Override.

**Step 11.** Choose the appropriate Send to PCE option.

a. When the Send To PCE selection is set to No Records, also select the desired Associated Stop Code, Credit Stop Code and CHAR4 Code.

b. When the Send To PCE selection is set to Occasion Of Service, also select the desired Associated Stop Code.

**Step 12.** Assign access to the DSS Unit.

**Step 13.** Click the OK button when selections are complete.
4.4.2.2 Update a DSS Unit

The Update DSS Unit option allows the user to edit, but not delete, DSS Units for use with Event Capture.

Step 1. Select a DSS Unit from the list of DSS Units on the Management Menu [DSS Unit] screen.

Step 2. Click the Update button.

- The Edit DSS Unit screen will display for the selected DSS Unit (Figure 163)
Step 3. Update the fields as desired.

- On this screen, the DSS Unit Name, DSS Dept., Service, Medical Specialty, Cost Center, DSS Unit Status, Event Code Screens status, Default Date / Time, Send to PCE, Allow Category Use, Allow Duplicate Override, Associated Stop Code, Credit Stop Code, and CHAR4 Code fields can be updated.
- When updating an established DSS Unit, Send To PCE cannot be changed to Occasion Of Service. Occasion Of Service can only be chosen on initial DSS Unit setup. In addition, for an established DSS Unit with a Send To PCE set to Occasion Of Service, Send To PCE cannot be modified.
- When the DSS Unit Status is changed from Active to Inactive, the Event Code Screens options are Retain or Inactivate (Figure 164). If the user selects Retain, the Event Code Screens will remain active. If the user selects Inactivate, the Event Code Screens that were active will be inactivated.

![Figure 164: DSS Unit Status Changed from Active to Inactive](image)

- When the DSS Unit Status is changed from Inactive to Active, the Event Code Screens options are Reactivate or Remain Inactive (Figure 165). All Event Code Screens related to this DSS Unit will either be left alone or activated, depending on the user’s choice.

![Figure 165: DSS Unit Status Change from Inactive to Active](image)

Step 4. Click the OK button when selections are complete.

4.4.2.3 To Grant Access to a DSS Unit

From the Add or Update DSS Units screens, the user has the option to give specific users access to the DSS Unit being added or edited.

Step 1. Click the Access button at the bottom of the Add or Edit DSS Unit screen.

- The Grant Access to DSS Unit Screen opens and has Include and Exclude fields (Figure 166).

Step 2. Type the starting characters of the last name in the upper portion of the Excluded list box, or simply scroll through the list to search for a last name.

- The Excluded list box contains the names of all active VistA users at the site.

Step 3. Grant access to a specific DSS unit by moving a user to the Included list box.

- Highlight a name in the Excluded list box and click the Include button or simply double-click the name in the Excluded list box.
• Access is denied by moving a user to the Excluded list box, either by highlighting a name in the Included list box and clicking the Exclude button, or by simply double-clicking the name in the Included list box.

Step 4. Click the Apply button to save the changes and continue granting access to additional users or click the OK button to save the changes and return to the previous screen.

Note:
• The IEN and Person Class/Classification for a selected user appear below the associated Excluded or Included list box.

Figure 166: Grant Access to DSS Unit

4.4.2.4 To Disable Categories for a DSS Unit

Step 1. Select a DSS Unit which allows categories from the list of DSS Units and click the Update button.

• The Edit DSS Unit screen opens for the selected DSS Unit (Figure 167).
Step 2. In the Allow Category Use section (Figure 168), click the No radio button, then click the OK button.

A warning pop up window appears stating that if categories are disabled, this setting cannot be re-instated (Figure 169).

Step 3. Click Yes to confirm.

On the Edit DSS Unit screen, the Event Code Screens section shows “None” listed in the Categories column. The Allow Category Use section is now disabled (Figure 170).
Step 4. Click OK to return to the Management Menu [DSS Units] screen.

Notes:
- Once categories are disabled for a DSS Unit, any fields for entering category information for that DSS Unit will be disabled on all Event Capture screens.
- Once categories are disabled for a DSS Unit, any previously entered workload will remain available for viewing and editing.
- A report is available to Management users which list all DSS Units that have changed from Allowed to Disabled Categories. (See Section 4.3.2.2)

4.4.3 Access by User - Grant Access to DSS Units by User

Before the User Starts
- Use extreme caution when using this option. Removing access to a specified DSS Unit for all users and inactivating the DSS Unit is not recommended without the permission of the associated service.
- Contact each service for a list of its Event Capture users and the DSS Units for which they enter data.
- The user must have access to a given DSS Unit before procedure data can be entered.
- Access can be provided to all DSS Units by assigning the ECALLU security key to a specified user (normally the DSS Manager or designee) using the Allocation of Security Keys option in the Key Management Menu under the Menu Management Menu.

Note:
- This option cannot be used to remove access to DSS Units for users who hold the ECALLU security key.

What the User Will See
- A list of users available for selection (Figure 171).
- For a selected user, the Available DSS Units and the Selected DSS Units display. Selected DSS Units represent the DSS Units for which the selected user has access.

### 4.4.3.1 Assign User Access to DSS Units

**Step 1.** Select a user.

![Figure 171: Grant Access to DSS Units by User](image)

**Step 2.** Select DSS Unit(s) in the Available list by highlighting the particular unit and clicking on the Include button.

- The selected DSS Unit is added to the Selected list (Figure 172).
- Similarly, access to DSS Units can be removed for the selected user by highlighting a DSS Unit in the Selected list, then clicking the Exclude button.
4.4.4 Category - Add or Update Categories

This option allows Management users to enter or edit, but not delete, local categories in the EVENT CAPTURE CATEGORY file (#726).

DSS Units can be defined to use categories to group procedures during data entry. Categories are facility-specific; therefore, users can use names that best suit their facility. For example, for a DSS Unit named “Audiology and Speech,” categories could be named “Speech Evaluation” and “Audiology Testing.” It is acceptable to have both DSS Units that do use categories and DSS Units that do not use categories defined at a facility.

**Before the User Starts**
- The user can ignore this option if the site's DSS Units are defined for use without categories.
- Categories cannot be deleted, but this option can be used to inactivate or reactivate them.

**What the User Will See**
- After selecting Category – Add or Update Categories from the Management Menu, the first window displays a list of Category Names, the Date created, and the Inactivation Date (Figure 173).
- The Management Menu [Categories] screen provides options to Add or Update a category.
4.4.4.1 Add Categories

Step 1. Click the Add button, or use the menu bar, and select Edit > Add.

- The Add Category screen opens (Figure 174).
- The Status field defaults to “Active.”

Step 2. Enter the name of the category to be added and click the OK button.

4.4.4.2 Update Categories

Step 1. On the Management Menu [Categories] screen, select a category to modify and click Update.

- The Update Category screen displays (Figure 175).

Step 2. Change the category to its new status by clicking Active or Inactive.

Step 3. Click the OK button to file the change and return to the previous screen.
The Management Menu [Categories] screen will reflect the changes made. If the category was inactivated, the Inactivation Date will display the current date.

The Export button enables users to export the data to an Excel spreadsheet (Figure 176).

### 4.4.5 Procedure - Add or Update Local Procedures

The Procedure option allows the user to enter or edit, but **not delete** local procedures in the EC National Procedure file (#725).

#### Before the User Starts

- Before using this option, print the National/Local Procedure Report from the Reports menu of the Event Capture Main Menu to print a list of procedures with their associated CPT codes. This report can be lengthy if it includes national procedures. This should be queued to print to a device during non-peak hours.
- Enter an associated CPT code to pass local procedures to the PCE software.
- A local procedure code number is required for any new local procedure.
- The local number code must be five characters in length, starting with an uppercase alpha character, followed by four alphabetic or numeric characters. This number will be used as the national code number for the new local procedure.
- With functionality put in place by the Code Set Versioning project, only active CPT codes are made available, and are based on the date a local procedure is added.

#### What the User Will See

- After selecting Procedure - Add or Update Local Procedures from the Management Menu, the first screen displays a list consisting of Procedure Name, Number, CPT Code and CPT Description, and Active status (Figure 177).
- The Procedures screen provides options to Add or Update a procedure.
4.4.5.1 Add Procedures

Step 1. Click the Add button, or use the menu bar, and select Edit > Add.

- The Add Local Procedure screen opens (Figure 178).

Step 2. Enter the new local Procedure Name.

Step 3. Enter the local Procedure Number.

Step 4. Enter the CPT Code if the data will transmit to the PCE software.

- The CPT Code and Description field contains CPT Code look-up functionality. The user can search for an existing CPT Code by code, a portion of the code, or a part of the description.

Step 5. Select the Status (Active or Inactive).

- The Status field defaults to “Active.”

Step 6. Click the OK button. The new local procedure has been added.
When attempting to file a new Local Procedure, the system compares the new procedure to the National Procedure code file to prevent duplication. If there is a conflict, a message is displayed, and the local procedure is not added.

4.4.5.2 Update Procedures

Step 1. Highlight the existing record and click the Update button, or double-click the row.

- The Edit Local Procedure screen opens (Figure 179).

![Figure 179: Edit Local Procedure](image)

Step 2. Edit the Procedure Name, Procedure Number, CPT Code and Description, and/or Status.

- Local procedures cannot be deleted, but the Status can be used to inactivate or reactivate them.
- The CPT code for a local procedure can be deleted by deleting the value in the CPT Code and Description field, then clicking the OK button.

Step 3. Click the OK button.

- The updated local procedure appears on the Procedures screen (Figure 180).
The Procedures listing can be exported to Excel. The tab in Excel is titled “ECS Procedure Table Export” (Figure 181).

4.4.6 Reason - Add or Update Procedure Reasons

Reasons are site-defined descriptions explaining why a procedure was performed for a patient.

Before the User Starts

- Users with the ECMGR security key can activate or inactivate existing reasons.
- If a reason is listed as inactive, it will not appear on the dropdown list for reasons on any screen.
- Event Capture managers can add a new reason using the Event Capture – New Reason screen.
- New reasons will immediately be available for use in data entry.
What the User Will See

- After selecting Reason – Add or Update Procedure Reasons from the Management Menu, the first screen displays a list of Active Reasons and Inactive Reasons (Figure 182).

Figure 182: Management Menu [Reasons] Screen

4.4.6.1 Activate Reasons

Step 1. Highlight one or more items from the Inactive Reasons list box and click the Activate button.

- To move more than one reason, press and hold the <Ctrl> key and then highlight additional items (Figure 183).

Figure 183: Reasons Screen with Inactive Reasons Selected

The Inactive Reason(s) selected will appear in the Active Reasons column when the Activate button is clicked (Figure 184).
Click the **Apply** button to apply the changes and continue working, or click the **OK** button to apply the changes and exit the screen. A confirmation prompt will appear. Click the **Yes** button to save the changes (Figure 185).

![Figure 185: Confirmation Prompt](image)

### 4.4.6.2 Inactivate Reasons

**Step 1.** Highlight item(s) from the Active Reasons list box and click the **Inactivate** button.

- To move more than one reason, click and hold the `<Ctrl>` key and then highlight additional items (Figure 186).

![Figure 186: Reasons Screen with Active Reasons Highlighted](image)

The Active Reason(s) selected will appear in the Inactive Reasons column when the Inactivate button is clicked (Figure 187).
Click the **Apply** button to apply the changes and continue working, or click the **OK** button to apply the changes and exit the screen. A confirmation prompt will appear (Figure 188). Click the **Yes** button to save the changes.

![Confirmation Prompt](image)

### 4.4.6.3 Add a New Reason

**Step 1.** Click the **Add** button.

- The Event Capture – New Reason screen will appear (Figure 189).

![New Reason Screen](image)

**Step 2.** Type the name of the new reason, then click the **OK** button to add the reason to the Active Reasons column. Click the **Cancel** button to exit the screen without saving the record.

- Once the new reason is added, it will appear on the Reasons screen (Figure 190).
4.4.7 Event Code Screen - Add, Update, or Copy Event Code Screens

The Event Code Screen option allows the user to create Event Code Screens for one or all Event Capture locations. Event Code Screens define procedure information. During data entry, users can select only the procedures defined in the Event Code Screens.

Before the User Starts

- Use the Location - Update Location Information option to create an Event Capture location before using this option.
- Use the DSS Unit - Add or Update DSS Units option to establish DSS Units before using this option.
- Event Code Screens must be defined before entering any Event Capture data.
- A prompt for Category occurs only if the Event Code Screen uses categories to group procedures.
- The user must define an active Associated Clinic and CPT code to pass Event Code procedures to PCE.
- With functionality put in place by the Code Set Versioning project, only active CPT codes can be selected and they will be based on the date the Event Code Screen is being set up.
- The Event Code Screen enables the use of characters “/” and “-” in the search field.
- The Associated Clinic on the Event Code Screen is not auto-populated.
- The Print and Export buttons are available on the Event Code Screen.
- Users with the ECMGR key will be able to copy EC screens to another DSS Unit.

What the User Will See

- After selecting Event Code Screen - Add or Update Event Code Screens from the Management Menu, the first screen displays a dropdown box of DSS Units.
- Select a DSS Unit to display the Event Code Screen data. Options to search by “Active” or “Inactive” status are also available. Columns include Synonym, Procedure, Location, Default Associated Clinic, Category and Status (Figure 191).
Click the **Print** button to print the Event Code Screens listing. When printing the report, the user will be prompted to choose Active, Inactive or All for the Clinic Status (Figure 192).

The Event Code Screens information can also be exported to Excel. The user will be prompted to choose Active, Inactive or All for the Clinic Status. The tab in Excel is titled “Event Code Table Export” (Figure 193).
4.4.7.1 Add Event Code Screens

Step 1. Select a DSS Unit from the dropdown list.

Step 2. Click the Add button or use the menu bar, and select Edit > Add.

- The Add Event Code Screen will appear (Figure 194).

![Figure 194: Add Event Code Screen](image)

Step 3. In the corresponding fields, select the DSS Unit, Category (if enabled), Location (one/many/all), Procedure, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated Clinic.

Step 4. Click the OK button.

- The Event Code Screen record is filed. The Add Event Code Screen closes, and the newly added Event Code Screen is displayed in the list (Figure 195).

![Figure 195: Event Code Screen Added](image)
Note:

- If the user selects an inactive Associated Clinic and then clicks OK, an error message appears (Figure 196). Click OK on the error message to close it and return to the Add Event Code Screen. From there, the user can select an active Associated Clinic.

Figure 196: Add Event Code Screen - Record Not Filed Error

4.4.7.2 Update Event Code Screens

Step 1. Select a DSS Unit from the dropdown list.
Step 2. Highlight a procedure, then click the Update button or use the menu bar, and select Edit > Update.

- The Update Event Code Screen form opens and displays the following fields: DSS Unit, Category, Location, Procedure, Status, Procedure Synonym, Default Volume, Ask Reasons, and Default Associated Clinic (Figure 197).

Figure 197: Update Event Code Screen Example

Note:

- If the user attempts to update an Event Code Screen that has an inactive Associated Clinic, an error message appears (Figure 198). The user has the option to select an appropriate active clinic or to leave the Associated Clinic blank.
Figure 198: Update EC Screen Error – Invalid Associated Clinic

Step 3. On the Update Event Code Screen, update the Procedure Synonym, Default Volume, Status, Ask Reason and/or Default Associated Clinic field values as desired (Figure 199).

- The Default Associated Clinic list box displays only active locations in the HOSPITAL LOCATION file (#44) whose type is “C” (clinic) and is a “count” clinic.
- If an Associated Clinic has non-conforming stop codes, the clinic will not be selectable.

Figure 199: Update Event Code Screen – Select Default Associated Clinic

Step 4. Click the OK button.

- The changes for the Event Code Screen record are filed. The Update Event Code Screen closes, and the newly added Event Code Screen is displayed in the list.

4.4.7.3 Copy Event Code Screens to Another DSS Unit

Step 1. Highlight a DSS Unit that has an Active status (Figure 200).
Step 2. From the menu bar, select Edit > Copy EC Screens to another DSS Unit (Figure 201).

- The Select a target screen appears (Figure 202).

Step 3. Select a target DSS Unit (usually newly created) from the dropdown list, and then click the OK button.

**Note:**
- The target DSS Unit is usually newly created by the user, but an existing DSS Unit may also be used.
The Copy Event Capture Screen to <user-selected target DSS Unit> displays (Figure 203).

![Copy Event Code Screen to DSS Unit](image)

- The Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated Clinic fields can be modified on this screen.
- The DSS Unit, Category, and Procedure cannot be edited.

**Note:**
- If the DSS Unit is setup to not send records to PCE, the Default Associated Clinic is disabled.

**Step 4.** Review the field selections and make edits (if necessary).

**Step 5.** Click the OK button to save the changes and create the copy.

- The next Event Code Screen will appear.
- To skip an Event Code Screen, click the **Skip** this EC Screen button. The next Event Code Screen will appear.

**Step 6.** When all needed Event Code Screens are copied, select the Close button to return to the Event Code Screen.

- All of the previous changes will be saved.
- One, many or all Event Code Screens can be copied.

**Notes:**
- If the user does not select a Location when copying an Event Code Screen, the record will not be filed, and two error messages will appear (Figure 204).
- Click the OK button on each error dialog to return to the Copy Event Code Screens form and enter a Location.
4.4.8 **Inactivate EC Screen - Identify Inactive Multiple Event Code Screens**

The Inactivate EC Screen option allows the user to identify active Event Code (EC) Screens that use a selected EC product code.

**Before the User Starts**

- Users with the ECMGR security key can select an EC Product Code (CPT Code, National EC Procedure Code or Local EC Procedure Code) and then display all of the DSS Units using the selected Product Code on the Inactivate Selected Event Code (EC) Screens for Given Procedure Code form.
- Choose to inactivate Event Code Screens by using the checkboxes in front of each entry.
- The user can display and print a list of Event Code Screens inactivated for a chosen EC Product Code.

**What the User Will See**

- After clicking the Inactivate EC Screen button on the Management Menu, the Event Capture – Inactivate Selected Event Code (EC) Screens for Given Procedure Code form will be displayed (Figure 205).
4.4.8.1 Inactivate Event Code Screen(s)

Step 1. Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local EC Procedure Code) in the search field and click the Search button.

- All currently active Event Capture Product Codes are available for selection.
- The associated DSS Units with IENs, Locations and Categories appear for the EC Product Code selected (Figure 206).

Figure 206: Inactivate Selected Event Code (EC) Screens with CPT Code Selected

Step 2. Use the checkboxes on the left side of the screen to select entries to be inactivated.

- The user can select multiple checkboxes (Figure 207).

Step 3. Click the Apply button to apply the changes and continue working, or click the OK button to apply the changes and exit the screen.

- A confirmation prompt will appear. Click the Yes button to continue inactivating the selections. Click No to return to the previous screen (Figure 207).

Figure 207: Confirmation Prompt

- When the user clicks Apply, a list of inactivated Event Code Screens are displayed (Figure 208).
• Click the Print button to print the list of inactivated EC screens.

**Figure 208: List of EC Screens That Were Inactivated**

Step 4. Click the OK button.

  • The changes are applied, and the user is returned to the Management Menu.

Step 5. To verify that the Event Code Screens are inactivated, use the Inactivate Event Code Screens option, and reenter the Event Capture Product Code that was previously used.

  • The list of DSS Units, Locations and Categories does not include the inactivated Event Code Screens.

4.4.9 Providers - Maintain Non-Licensed Providers

This option allows the Package Manager user to create a list of Non-Licensed Providers (i.e., staff without a Person Class). Workload for non-licensed providers can be entered for DSS Units that do not send records to PCE.

**Before the User Starts**

  • For DSS Units that do not send to PCE, both Non-Licensed Providers (without a Person Class) and Providers (with a Person Class) may be selected as providers when entering a workload.
  • For DSS Units that send records to PCE (including Occasion Of Service DSS Units), staff without a Person Class may not be selected as a provider.

**What the User Will See**

  • After clicking the Providers button on the Management Menu, the Non-Licensed Provider Maintenance screen will be displayed (Figure 209).
4.4.9.1 Add a Non-Licensed Provider

Step 1. Highlight a staff member name in the Excluded list box, then click the Include button (Figure 210).

Step 2. Click OK to accept the changes.

- Once a staff member has been added to the Included list as a non-licensed provider for any DSS Unit that does not send to PCE, this staff member will be selectable as a provider when entering workload (Figure 211).
4.4.9.2 Remove a Non-Licensed Provider

Step 1. Highlight a staff member name in the Included list box, then click the Exclude button (Figure 212).

Step 2. Click OK to accept the changes.

- Once a staff member has been added to the Excluded list and removed as a non-licensed provider, the staff member will no longer be selectable as a provider when entering workload for DSS Units that do not send to PCE.
5 Troubleshooting

The following subsections present some typical problems experienced by end users and the corresponding resolutions.

5.1 Access Issues

Users need an Access Code and Verify Code obtained from their local IRM staff to use the Event Capture GUI.

5.2 Log On Issues

Event Capture is usually accessed through a desktop shortcut which points to the installation location. Ask the local support staff for assistance.

If Event Capture launches and then disappears or is not responding, make sure the IP address listed is correct and not blocked by firewall software for the system with which it is communicating. Local support staff is available to assist with issues.

5.3 GUI Appears Distorted

If the ECS GUI display appears to be missing scrollbars, columns or rows, ensure that the screen resolution is set to a resolution of 1440 x 900, or greater. Settings available will be dependent upon the user’s monitor size.

5.3.1 Example of Setting the Screen Resolution to 1920 x1080

Step 1. Right-click anywhere on the desktop and select Screen resolution (Figure 213).

The Windows Screen Resolution options appear (Figure 214).
Step 2. Select 1920 x 1080 from the Resolution settings, and then click the OK or Apply button (Figure 215).

Note:
- Depending on the user's version of Windows, this may look different.
Appendix A.  Acronyms and Abbreviations

Table 3 lists the acronyms and abbreviations used throughout the ECS FY20 User Guide.

Table 3: Acronyms and Abbreviations

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2FA</td>
<td>Two-Factor Authentication</td>
</tr>
<tr>
<td>ADPAC</td>
<td>Automatic Data Processing Application Coordinator</td>
</tr>
<tr>
<td>CCOW</td>
<td>Clinical Context Object Workgroup</td>
</tr>
<tr>
<td>CHAR4</td>
<td>A 4-character code</td>
</tr>
<tr>
<td>CM</td>
<td>Clinical Modification</td>
</tr>
<tr>
<td>CPRS</td>
<td>Computerized Patient Record System</td>
</tr>
<tr>
<td>CPT</td>
<td>Current Procedural Terminology</td>
</tr>
<tr>
<td>DIAG</td>
<td>Diagnosis</td>
</tr>
<tr>
<td>DSS</td>
<td>Decision Support System</td>
</tr>
<tr>
<td>EC</td>
<td>Event Capture</td>
</tr>
<tr>
<td>ECALLU</td>
<td>Security Key - Event Capture All DSS Units</td>
</tr>
<tr>
<td>ECMGR</td>
<td>Security Key - Event Capture Manager</td>
</tr>
<tr>
<td>ECNORPT</td>
<td>Security Key - Event Capture No Reports</td>
</tr>
<tr>
<td>ECPATIENT</td>
<td>Event Capture Patient</td>
</tr>
<tr>
<td>ECPROVIDER</td>
<td>Event Capture Provider</td>
</tr>
<tr>
<td>ECS</td>
<td>Event Capture System</td>
</tr>
<tr>
<td>ECSPSH</td>
<td>Security Key - Event Capture Spreadsheet</td>
</tr>
<tr>
<td>FY</td>
<td>Fiscal Year</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>ICD</td>
<td>International Classification of Diseases</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>IEN</td>
<td>Internal Entry Number</td>
</tr>
<tr>
<td>IPC</td>
<td>Inactive Person Class</td>
</tr>
<tr>
<td>IRM</td>
<td>Information Resource Manager</td>
</tr>
<tr>
<td>JAWS</td>
<td>Job Access with Speech</td>
</tr>
<tr>
<td>MAS</td>
<td>Medical Administration Service</td>
</tr>
<tr>
<td>MCA</td>
<td>Managerial Cost Accounting</td>
</tr>
<tr>
<td>MCAO</td>
<td>Managerial Cost Accounting Office</td>
</tr>
<tr>
<td>N/A</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>NPCD</td>
<td>National Patient Care Database</td>
</tr>
<tr>
<td>PCE</td>
<td>Patient Care Encounter</td>
</tr>
<tr>
<td>PIMS</td>
<td>Patient Information Management System</td>
</tr>
<tr>
<td>PIV</td>
<td>Personal Identification Verification</td>
</tr>
<tr>
<td>SC</td>
<td>Service Connected</td>
</tr>
<tr>
<td>Acronym</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>SSN</td>
<td>Social Security Number</td>
</tr>
<tr>
<td>SSO</td>
<td>Single Sign-on</td>
</tr>
<tr>
<td>T&amp;TC</td>
<td>Section 508 Accessibility Testing and Training Center</td>
</tr>
<tr>
<td>VA</td>
<td>Veterans Affairs</td>
</tr>
<tr>
<td>VAMC</td>
<td>Veterans Affairs Medical Center</td>
</tr>
<tr>
<td>VDL</td>
<td>VA Software Document Library</td>
</tr>
<tr>
<td>VHA</td>
<td>Veterans Health Administration</td>
</tr>
<tr>
<td>VIP</td>
<td>Veteran-focused Integrated Process</td>
</tr>
<tr>
<td>VistA</td>
<td>Veterans Health Information Systems and Technology Architecture</td>
</tr>
</tbody>
</table>
# Appendix B. Glossary

Table 4 lists some of the terms used throughout the ECS FY20 User’s Guide.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Clinic</td>
<td>The Associated Clinic of the Event Capture (EC) Procedure. CLINIC IEN is retrieved from the ASSOCIATED CLINIC field (#26) of the EVENT CAPTURE PATIENT file (#721).</td>
</tr>
<tr>
<td>Associated Stop Code</td>
<td>The Stop Code that most closely represents the DSS Unit workload.</td>
</tr>
<tr>
<td>Category</td>
<td>Category provides Event Capture a common level to group associated procedures. Multiple procedures can be defined for each category.</td>
</tr>
<tr>
<td>CCOW</td>
<td>In the context of health informatics, CCOW is a Health Level-7 international standard protocol designed to enable disparate applications to synchronize in real time, and at the user interface level.</td>
</tr>
<tr>
<td>CHAR4 Code</td>
<td>A 4-character code value of the associated clinic as specified from the DSS Clinics and Stop Code Worksheet File.</td>
</tr>
<tr>
<td>Combat Veteran</td>
<td>Identifies if patient served in a combat zone. Veteran must have served in active duty in a theatre of combat operations during a period of war after the Persian Gulf War or in combat against a hostile force during a period of hostilities after November 11, 1998.</td>
</tr>
<tr>
<td>Computerized Patient Record System (CPRS)</td>
<td>Parameters are set up/maintained by the facility’s CPRS Coordinator/Clinical Application Coordinator (CAC).</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Cost Center reveals which service is using this DSS Unit.</td>
</tr>
<tr>
<td>Conforming Clinics</td>
<td>Clinics that have stop codes in compliance with their restriction types. Stop codes are used in accordance to their assigned restriction types. Stop codes with restriction type 'P' can only be used in the primary stop code position. Stop codes with restriction type 'S' can only be used in the secondary stop code position. Stop codes with restriction type 'E' can be used in either the primary or secondary stop code position.</td>
</tr>
<tr>
<td>Count Clinic</td>
<td>A clinic for which workload entered is credited.</td>
</tr>
<tr>
<td>Credit Stop Code</td>
<td>The Credit Stop Code (from the HOSPITAL LOCATION file [#44]) as determined by Medical Administration Service (MAS). This is a DSS Identifier assigned to a clinic and may be utilized in several ways. We can use it to identify different provider types (NP, PA, Psychologist, etc.) and also for various program groups (Care Coordination, Telemedicine, etc.) or to give additional credit to a second service in a joint clinic. DSS further uses credit stop codes to create unique feeder keys to identify clinic intermediate products. (Examples are; 123-Nutrition Individual, 124-Nutrition Group, 372-MOVE! Individual, 373-MOVE! Group.)</td>
</tr>
<tr>
<td>Current Procedural Terminology (CPT) code</td>
<td>CPT codes are published by the American Medical Association. The purpose of the coding system is to provide uniform language that accurately describes medical, surgical, and diagnostic services.</td>
</tr>
<tr>
<td>Current Procedural Terminology (CPT) Modifier</td>
<td>CPT modifiers provide the ability to refine CPT procedure codes to better reflect procedures performed.</td>
</tr>
</tbody>
</table>

---

_ECS FY20 EC*2.0*148_ 
B-1 
July 2020
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DSS Unit</strong></td>
<td>A DSS (Decision Support System) Unit defines the lowest level segment used for tracking hospital resources. These units can be a small work unit within a service or a large division within a service. Management at each facility is responsible for tailoring the DSS Units to fit its resource/cost reporting.</td>
</tr>
<tr>
<td><strong>DSS Unit Number</strong></td>
<td>This code is used for additional identification of DSS Units.</td>
</tr>
<tr>
<td><strong>Event Capture</strong></td>
<td>Software designed to provide management tools necessary in tracking procedures not entered in other VistA packages. Event Code Screens are unique combinations of location, DSS Unit, category, and procedure that define patient procedures.</td>
</tr>
<tr>
<td><strong>Event Code Screen</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Graphical User Interface (GUI)</strong></td>
<td>A type of display format that enables users to choose commands, initiate programs, and other options by selecting pictorial representations (icons) via a mouse or a keyboard.</td>
</tr>
<tr>
<td><strong>ICD-10-CM</strong></td>
<td>International Classification of Diseases, Tenth Revision, Clinical Modification codes (based on the World Health Organization codes).</td>
</tr>
<tr>
<td><strong>Internal Entry Number (IEN)</strong></td>
<td>The number used to identify an entry within a file. Every record has a unique internal entry number.</td>
</tr>
<tr>
<td><strong>Ionizing Radiation (ION RAD)</strong></td>
<td>Exposure to ionizing radiation.</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>Initializing the user site as a location, the Event Capture software recognizes the user facility as a valid location to enter Event Capture data.</td>
</tr>
<tr>
<td><strong>Medical Administration Service (MAS)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Non-conforming Clinics</strong></td>
<td>Clinics with stop codes that do not comply with the assigned stop code restriction types of P=Primary, S=Secondary and E=Either.</td>
</tr>
<tr>
<td><strong>Non-count Clinic</strong></td>
<td>A clinic for which there is no workload credited.</td>
</tr>
<tr>
<td><strong>Ordering Section</strong></td>
<td>The medical section ordering the patient’s procedure.</td>
</tr>
<tr>
<td><strong>Parent Service</strong></td>
<td>The controlling service for a DSS Unit.</td>
</tr>
<tr>
<td><strong>Patient Care Encounter (PCE)</strong></td>
<td>The VistA Outpatient Encounters System. PCE builds a single encounter for each recorded instance of a patient receiving services within a clinic. PCE is the mechanism for the transmission of all encounter data to the National Patient Care Database (NPCD). For outpatient encounters, DSS combines all instances with the same SSN, Date, and Primary Stop code into one outpatient encounter. However, on DSS, each of the clinic encounters of PCE appears as a resource utilization unit under the one encounter. This means that in DSS, a single outpatient encounter will be built by two or more records when they have a common encounter number. The PCE column reflects if workload is set to pass to PCE. Values include: All – Send all records OOS – Send Occasion Of Service records No – Send no records.</td>
</tr>
<tr>
<td><strong>Patient Information Management System (PIMS)</strong></td>
<td>Formerly Medical Administration Service (MAS).</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Procedure</td>
<td>A specific function performed on, or service provided to, a patient. Multiple procedures can be associated with a single category.</td>
</tr>
<tr>
<td>Procedure Reason</td>
<td>A method of generically grouping patient procedures to further describe the event, often giving patient or provider information.</td>
</tr>
<tr>
<td>Procedure Synonym</td>
<td>See Synonym</td>
</tr>
<tr>
<td>Provider</td>
<td>The provider of care performing the procedure. This provider can be a doctor, nurse, technician, or any designated team of medical professionals.</td>
</tr>
<tr>
<td>Reason</td>
<td>See Procedure Reason</td>
</tr>
<tr>
<td>Security Key</td>
<td>Security Keys set a layer of protection on the range of computing capabilities available with a particular software application. The availability of options is based on the level of system access granted to each user.</td>
</tr>
<tr>
<td>Service Connection</td>
<td>The service connection (SC) box on the Enter/Edit Patient Data screen in ECS must be answered if it displays as a required option for that patient. Adjudicated service connection means that the facts, shown by evidence, establish that a particular injury or disease resulting in disability was incurred coincident with service in the Armed Forces, or if preexisting such service, was aggravated therein.</td>
</tr>
<tr>
<td>Southwest Asia Conditions</td>
<td>Patient encounter is related to exposure to Southwest Asia conditions while serving in the Southwest Asia Theater of operations.</td>
</tr>
<tr>
<td>Station Number</td>
<td>A Station Number uniquely identifies every VA primary facility and division; however, entries for some facility types do not have Station Numbers. Station Numbers are stored in Field #99 in the VistA M Server INSTITUTION file (#4).</td>
</tr>
<tr>
<td>Stop Code</td>
<td>A three-digit number that is used in VHA to identify the services that a patient receives at a Department of Veterans Affairs (VA) medical facility. Stop codes are also used to capture workload statistics. A stop code could either be classified as a primary or secondary stop code, (which is referenced as credit stop code). The Stop Code (from the HOSPITAL LOCATION file [#44]) as determined by Medical Administration Service (MAS).</td>
</tr>
<tr>
<td>Synonym</td>
<td>A locally recognized name or description for a procedure. In VistA, this is a field in the OPTION file (#19). Options may be selected by their menu text or synonym.</td>
</tr>
<tr>
<td>T&amp;TC</td>
<td>Section 508 Accessibility Testing and Training Center.</td>
</tr>
<tr>
<td>Unit IEN</td>
<td>The internal entry number (IEN) for this record. The number to identify this DSS unit locally at the users site (1 to 14 characters). The same DSS Unit number can be used for more than one DSS Unit.</td>
</tr>
<tr>
<td>Verify Code</td>
<td>A secret password used along with the Access Code to provide secure user access to the VistA M Server. It is used by Kernel's Sign-on/Security system along with the Access code to validate the user's identity.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VistA</td>
<td>Veterans Health Information Systems and Technology Architecture (VistA) is the proprietary software developed for and used by the VA VHA to support its clinical and administrative functions at VA sites nationwide. It is both client- and server-based software. The client-based software is written in Java, Borland Delphi Pascal, and other GUI-based languages and runs on the Microsoft operating system. The server-based software is written in the M programming language and, via Kernel, runs on all major M implementations regardless of the vendor. It is composed of integrated clinical, infrastructure, and financial/administrative software applications. This internally developed portfolio of applications is recognized as the most comprehensive integrated health information system in the United States.</td>
</tr>
<tr>
<td>Volume</td>
<td>Volume is usually associated with the number of procedures performed. This field can also be used to track number of bed days, or to track time increments actually spent performing the procedure. For example, if “15-minute increment” is the unit, volume of 1 = 15 minutes, volume of 2 = 30 minutes, etc.</td>
</tr>
</tbody>
</table>
Appendix C. Other ECS Package Management Information

Set up an ECS mail group in VistA to receive relevant ECS notifications. Contact IT to set up a VistA ECS Mail Group so more than one person receives ECS administrative messages.

Examples of ECS package administrative email messages:

- When a new ECS patch is released
- When a patch updating National Procedure Codes is released
- When Event Code Screens are inactivated due to changes in National Procedure Codes
- When terminated users result in access to DSS Units being affected.

Figure 216 is a screen capture of an example of the email message a user could receive when an ECS patch is released.

![Figure 216: Example Email Message when an ECS Patch is Released](image)

Figure 217 is a screen capture of an example of the email message a user could receive when a patch that updates National Procedure Codes is released.
When an EC NATIONAL PROCEDURES file (#725) patch is loaded, a review of the EVENT CODE SCREENS file (#720.3) is performed. Event Code Screens, which have either inactive CPT or procedure codes, or a procedure code with an inactive “default” CPT code attached, are reported.
Figure 218 is a screen capture of an example of the message a user could receive stating that Event Code Screens should be reviewed due to changes in the EC NATIONAL PROCEDURES file (#725).

**Figure 218: Example of Event Code Screens to Review Message**

**Example**

From: <EMAIL ADDRESS PROTECTED>
Sent: Monday, MONTH DD, YYYY 9:00 PM
To: Package Manager
Subject: Event Code Screens to Review

Please forward this message to your local DSS Site Manager or Event Capture ADPAC.

A review of the EC EVENT CODE SCREENS file (#720.3) was done after installation of patch EC*2*XX which updated the EC NATIONAL PROCEDURE file (#725). This message provides the results of that review.

The EC EVENT CODE SCREENS file (#720.3) records indicated below point to an inactive record in the EC NATIONAL PROCEDURE file (#725) or to an inactive record in the CPT file (#81).

The user should use the Inactivate Event Code Screens [ECINACT] option to inactivate the Event Code Screen. If necessary, a new Event Code Screen can be created using a currently active CPT code or National Procedure.

The CPT procedure for the following Event Code Screen (XXX-X-X-XXXXX) is inactive --

- Location: VAMC
- Category: Treatment
- DSS Unit: E-KINESIOTHERAPY-IP
- Procedure: PROSTHETIC TRAINING (97520)

The CPT procedure for the following Event Code Screen (XXX-X-X-XXXXX) is inactive --

- Location: VAMC
- Category: Treatment
- DSS Unit: E-KINESIOTHERAPY-IP
- Procedure: PROSTHETIC CHECKOUT (97703)

The CPT procedure for the following Event Code Screen (XXX-XX-X-XXXXX) is inactive --

- Location: VAMC
- Category: None
- DSS Unit: PSYCHOLOGY-IP
- Procedure: PSYCHOLOGICAL TESTING (96100)

**Notes:**

After a patch updating file #725:

- Check for inactivated national procedure codes.
- Check for Event Code Screens with out-of-date procedure codes.
Figure 219 is a screen capture of an example of the email message a user could receive when an ECS User is terminated.

**Figure 219: Example 1 – ECS User Terminated Email Message**

**Example 1**

Subj: Removed Terminated Users from DSS UNIT Access [XXXXXXXX] MM/DD/YY @ 02:30 B lines
From: EVENT CAPTURE in ‘IN’ basket. Page 1 “New”

---

Event Capture - Terminated Users removed from DSS UNIT

Total number of Terminated users: 1

DSS UNITS   NAME of Terminated User Removed from DSS UNIT

HCBC REFERRALS/STATS PROVIDER1, EC
HCBC STAFF PHONE   PROVIDER1, EC
HCBC STAFF PHONE NOT W/PT PROVIDER1, EC
HCBC VA STAFF   PROVIDER1, EC
SOCIAL WORK - INPATIENT PROVIDER1, EC
SOCIAL WORK - OUTPATIENT PROVIDER1, EC
SOCIAL WORK-C&P PROVIDER1, EC
SOCIAL WORK-GEN PROVIDER1, EC

Enter message action (in IN basket): Delete/

Figure 220 is a screen capture of another example of the email message a user could receive when an ECS User is terminated.

**Figure 220: Example 2 – ECS User Terminated Email Message**

**Example 2**

Event Capture - Terminated Users removed from DSS UNIT

Total number of Terminated users: 1

DSS UNITS   NAME of Terminated User Removed from DSS UNIT

HCBC REFERRALS/STATS PROVIDER1, EC
HCBC STAFF PHONE   PROVIDER1, EC
HCBC STAFF PHONE NOT W/PT PROVIDER1, EC
HCBC VA STAFF   PROVIDER1, EC
SOCIAL WORK - INPATIENT PROVIDER1, EC
SOCIAL WORK - OUTPATIENT PROVIDER1, EC
SOCIAL WORK-C&P PROVIDER1, EC
SOCIAL WORK-GEN PROVIDER1, EC
Appendix D. Index

Associated Clinic ................................................................................................................................. 65, 79, 100, 110
Caveats and Exceptions .......................................................................................................................... 17
Changing User ID and Password ............................................................................................................. 17
CHAR4 .................................................................................................................................................... 72, 110
CHAR4 Code ............................................................................................................................................ 65
Continuity of Operations .......................................................................................................................... 6
CPRS ......................................................................................................................................................... B-1
CPT Code ................................................................................................................................................ 79, 85
Credit Stop ............................................................................................................................................. 65, 99
Credit Stop Code .................................................................................................................................... 72, 110
Data Entry Menu ..................................................................................................................................... 19
Data Flows .............................................................................................................................................. 5
Document Orientation .............................................................................................................................. 1
Edit Cell Data on the Spreadsheet Upload Form .................................................................................... 54
Event Capture Main Menu ..................................................................................................................... 12
Exit System ............................................................................................................................................ 17
Getting Started ..................................................................................................................................... 7
ICD ............................................................................................................................................................ 26, 38
ICD-10 ................................................................................................................................................... 79
Import a Regular Spreadsheet ................................................................................................................ 49
Import a State Home Spreadsheet ......................................................................................................... 56
Introduction ............................................................................................................................................ 1
Logging On ........................................................................................................................................... 8
Management Menu ................................................................................................................................. 113
Menu Bar for Specific Functions ............................................................................................................ 15
Modify Column Order ............................................................................................................................. 55
National Patient Care Database .............................................................................................................. B-2
National Service Desk and Organizational Contacts ............................................................................ 3
Non Licensed Providers ........................................................................................................................... 144
Online Documentation ............................................................................................................................. 17
PCE ......................................................................................................................................................... 5, 25, 61, 68, 79, 111, 144, B-2
Person Class ........................................................................................................................................... 102, 144
Purpose .................................................................................................................................................. 1
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>63</td>
</tr>
<tr>
<td>Reports Available to ECMGR Key Holders Only</td>
<td>88</td>
</tr>
<tr>
<td>Section 508 Compliance</td>
<td>6</td>
</tr>
<tr>
<td>Spreadsheet</td>
<td>49</td>
</tr>
<tr>
<td>Stop Code</td>
<td>65, 72, 79, 99, 110</td>
</tr>
<tr>
<td>Synonym</td>
<td>65, 110</td>
</tr>
<tr>
<td>System Configuration</td>
<td>5</td>
</tr>
<tr>
<td>System Summary</td>
<td>5</td>
</tr>
<tr>
<td>Timeout Feature</td>
<td>18</td>
</tr>
<tr>
<td>Upload Imported Spreadsheet Data</td>
<td>58</td>
</tr>
<tr>
<td>User Access Levels</td>
<td>6</td>
</tr>
<tr>
<td>Window-Eyes</td>
<td>6</td>
</tr>
</tbody>
</table>